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1 Introduction

Altova SchemaAgent 2025 is an Altova technology that enables you to manage multiple schemas and build
relationships between W3C XML schemas from within a graphical user interface. SchemaAgent also provides a
display of relationships between Altova MapForce design (.mfd) files and their associated XML schemas or
instances. You can also view and modify relationships and dependencies for XSLT stylesheets and WSDL files.

Altova's SchemaAgent technology consists of two components:

· A SchemaAgent  server serves supported files to one or more SchemaAgent Clients on the network.
The server can be installed as a local server together with SchemaAgent Client, as an independent
Altova SchemaAgent Server installation, or run as a service.

· The SchemaAgent Client  is an application with a graphical user interface that provides access to
the files served by a SchemaAgent server. Using standard GUI mechanisms, such as copy-and-paste
and drag-and-drop, you can easily build relationships between the served files and make large-scale
changes—such as in path references—across multiple files.

SchemaAgent technology can also be used in Altova XMLSpy® Editor. XMLSpy communicates via
SchemaAgent Client with either LocalServer or SchemaAgent Server.

SchemaAgent in the Altova product range
Both SchemaAgent Server and SchemaAgent Client are to be downloaded separately from the SchemaAgent
download page at the Altova website and installed separately. SchemaAgent Server is available free of charge,
whereas SchemaAgent Client requires a license that must be purchased from Altova.

The Altova® MissionKit™ 2025 Enterprise Edition includes the SchemaAgent product and a license key for it.
The SchemaAgent Server application, however, is not included as part of the Altova® MissionKit™ 2025
packages, and must be downloaded from the SchemaAgent download page at the Altova website.

In order to use SchemaAgent with XMLSpy, SchemaAgent Client must be installed on the same machine as
XMLSpy. SchemaAgent Server can be installed anywhere on the network. XMLSpy Enterprise Edition and
XMLSpy Professional Edition (when purchased independently of Altova® MissionKit™ 2025 applications) can
both use SchemaAgent.

Note: Any SchemaAgent or SchemaAgent-related product from Altova (including XMLSpy) starting with Version
2005 release 3 is not compatible with versions of SchemaAgent or SchemaAgent-related products previous to
it.

Last updated: 17 March 2025

49
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https://www.altova.com/schemaagent
https://www.altova.com/schemaagent/download
https://www.altova.com/schemaagent/download
https://www.altova.com/schemaagent/download
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1.1 About this Documentation

This documentation provides an overview of how SchemaAgent technology works, and describes how to use
the SchemaAgent server and SchemaAgent Client. It also provides an overview of how Altova's XMLSpy
application (Enterprise and Professional Editions) can utilize SchemaAgent technology to provide powerful
schema editing and management capabilities.

This documentation is divided into the following parts:

· An introduction  to SchemaAgent and its mechanism.
· An overview of SchemaAgent's main features .
· A description of how to configure the search paths  for SchemaAgent.
· A SchemaAgent tutorial .
· A description of the installation, configuration, and use of SchemaAgent Server .
· A description of the installation, configuration, and use of SchemaAgent Client .

File Paths
File paths given in this documentation are not the same for all operating systems. Note the following
correspondences:

· Documents folder: Example files are located in the folder C:\Users\<username>\Documents\Altova.
· Application folder: The Application folder is the folder where your Altova application is located (by

default, C:\Program Files\Altova). When Schema Agent 32-bit is installed on a 64-bit operating
system, the path is C:\Program Files (x86)\Altova.

7
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1.2 System Requirements

Altova SchemaAgent Client and SchemaAgent Server run on the following operating systems:

· Windows 10, Windows 11
· Windows Server 2016 or newer

Both the 32-bit and 64-bit platforms are supported.
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1.3 SchemaAgent's Main Features

SchemaAgent Server processes client requests to create, update, or delete schema IIRs (Includes, Imports,
and Redefines) and manages client–server communication. It also processes all file-based manipulations:
create, delete, move, and rename.

Installation options
SchemaAgent Server can be installed as a standalone application with a graphical user interface, or as a
service.

Graphical user interface
SchemaAgent Server's graphical user interface (GUI) provides full environment information, including lists of
currently connected clients and all defined search paths. An Environment window displays all defined search
paths as hierarchical tree structures as well as all file extensions defined for schemas, MFD, XML, XSL/XSLT,
and WSDL files, and provides easy-to-use search path selection using Explorer-type browse functionality. The
main window in the right area of SchemaAgent Server displays all files with the defined file extensions that have
been found in the search paths.

Logging functionality
The user interface provides a Log window that displays detailed communications activity. The log reports can
be configured and written to CSV files.

Access to schemas on the web
SchemaAgent Server enables access to schemas located in WebDAV folders on (secure) WebDAV servers
with UNC paths and drive letters.

SchemaAgent Client provides a graphical user interface where you can view and build schema relationships
and manage large numbers of schemas. You can also view relationships between MapForce design files and
their associated schemas.

SchemaAgent designs
Schema designs help you to manage and organize schema collections intuitively. These designs can be saved
as SchemaAgent design files for subsequent editing. You can create, update, or delete IIRs (Includes, Imports,
and Redefines) between schemas by direct manipulation in a SchemaAgent design using drag-and-drop. Once
an IIR relationship is created or modified in a SchemaAgent design, that relationship is physically written into
the relevant schema (XSD) file(s) and any related schema file. To undo a modification to a relationship, you
must edit the SchemaAgent design accordingly.

For XSLT stylesheets, SchemaAgent Client allows you to create imports and includes as well as import
schemas or create new or display existing inline schemas.

The Design window also shows WSDL files where you can explore the content of the WSDL file and view its
internal schemas as well as all of its messages, port types, bindings, and services. The import of XML
schemas or different WSDL files is also possible.
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File administration
If a file is renamed or moved, the change is passed to all other files in the workspace that reference the
changed file. The advantage is that multiple files can be managed from within the SchemaAgent Client GUI,
thus obviating the need to edit individual files separately.

Viewing structures and relations
In the Design window, you can obtain a graphical view of the relationships between the source and target
schemas of MapForce design files, and all related schemas. IIRs can be viewed immediately and in greater
detail in the schema component itself and the detailed structure of schema components, such as elements and
complex types, can be displayed.

This applies also to XML instances, XSLT stylesheets and WSDL files. For each of these files, SchemaAgent
Client displays a file box in the Design window. These file boxes contain all the relevant information for a
particular file, structured in collapsed sections which can be expanded to view some of the data in detail.

Selecting or inserting related files
SchemaAgent Client offers several options to select file boxes or insert files that reference other files in the
workspace.

Integration with XMLSpy
If set up to work with SchemaAgent, Altova's XMLSpy provides powerful schema editing capabilities. While a
schema is being edited in the Schema/WSDL View of XMLSpy, components of all schemas in SchemaAgent
Server's search paths are listed in the Entry Helpers and can be modified and reused in the schema being
edited. Information about IIRs created or modified in Schema/WSDL View is written to related schemas.
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1.4 Configuring Search Paths

Search paths are the paths or folders that are scanned for XML Schemas, MapForce Design (.mfd) files, and
XML files. Depending on your SchemaAgent installation, you can configure (i.e., add, edit, or delete) search
paths in the Configure Paths tab of either SchemaAgent Client or SchemaAgent Server.

If you are working with a LocalServer, the Configure Paths tab is displayed as an additional tab in the Explorer
window of the SchemaAgent Client application.

If you have installed a SchemaAgent Server locally or in a network, the Configure Paths tab is displayed in
the Environment window of SchemaAgent Server. The Explorer window in SchemaAgent Client has no
Configure Paths tab if you are connected to SchemaAgent Server.
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Apart from its location, the Configure Paths tab is identical in both of the above-mentioned cases.

Search Path considerations
Depending on the installation location of SchemaAgent, certain file access and path restrictions may apply. If
you access schemas on a network share, make sure that the SchemaAgent application has the correct
access permissions.

File system support is as follows: 

· UNC paths are supported. Note that schema paths can be, or references within schemas can contain,
UNC paths or relative paths.

· WebDAV folders are supported. Location paths can be, or references within schemas can contain,
WebDAV folders or relative paths.

· FTP connections are supported. Files can be directly accessed using FTP.
· Mapped drives are supported. If drive letters are used in search paths, then machines hosting

SchemaAgent clients must have the identical drive letter mapped to the same shared folder.
· Local drives/directories are not directly supported. Access to local directories or resources, however, is

possible if the local directories are shared to the network and search paths on LocalServer are
configured to use the network shares.

1.4.1 Adding or Editing Search Paths

Before you can work with a file in SchemaAgent Client, it must be contained in one of the search paths that are
displayed in the Hierarchical and Flat tabs of the Explorer window. You cannot open files from outside
SchemaAgent Client or drag them into the Design window.
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Note: The procedure described below applies to the Configure Paths tab in both the Explorer window in
SchemaAgent Client and the Environment window in SchemaAgent Server. The type of your SchemaAgent
installation and the server you are connected to, respectively, determines in which window the Configure Paths
tab is displayed.

Relative paths
In SchemaAgent, you can define to display search paths relative to the location of the configuration file . This
allows you to have shorter search paths, if your folder structure is very extensive. Note that, with SchemaAgent
LocalServer, each user has a separate configuration file in ..\Documents\Altova\SchemaAgent
LocalServer2025.

To add or edit a search path:

1. In the Configure Paths tab of your respective SchemaAgent application, do one of the following:

· To add a search path, right-click the Search paths folder and select Add search path from the
context menu, or click the folder and press the Insert key.

· To edit a search path, right-click one of the existing search paths and select Edit search path from
the context menu.

The Add/Edit search path dialog box opens.

18
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2.  If the search path is a directory, do the following:

a) Select the Directory option and enter the search path in the Path text box. Alternatively, click
Browse to select the required directory; the selected directory is entered in the Path text box.

b) Select the Relative Path check box to make the search path entry relative; leave the check box
unchecked to use an absolute path.

If the search path is a URL, do the following:

a) Select the URL option and enter the server URL in the Server URL text box.
b) If authorization is required, select the Connect using a different user name check box and enter

the username and password.
c) If applicable, click Browse to select the required directory on the server.
 

3. Select the Recursive check box if you wish sub-directories of the selected directory to be searched. If
this check box is not selected, no sub-directories will be searched.

4. Click OK.
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To delete a search path:

1. In the Configure Paths tab of your respective SchemaAgent application, select the path you want to
delete and do one of the following:

· Right-click and choose Delete search path from the context menu.
· Press the Delete key.

2. Click Yes in the message box that pops up.

1.4.2 Configuring File Extensions

By default, SchemaAgent Client displays the following file types in the Hierarchical and Flat tabs of the
Explorer window:

· W3C XML Schema
· MapForce Design files
· XML files
· XSL and XSLT stylesheets
· Web Service Description Language (WSDL) files

The "File extensions" folder in the Configure Paths tab, therefore, has five sub-folders: Schema, MapForce,
XML, XSL/XSLT, and WSDL. Each of the sub-folders contains typical extensions for the respective format. You
can, however, define additional file extensions for any of the supported files.

To add a file extension:

1. In the Configure Paths tab of your respective SchemaAgent application, select a folder or a file
extension under the File extensions folder and do one of the following:

· Right-click and choose Add file extension from the context menu.
· Press the Insert key.

2. An entry named "newextension" is added to the respective folder and selected for editing. The

 button appears flashing red.
3. Enter the desired file extension and press Enter.
4. Click the Reload search paths button to display files with the newly added file extension in the

Explorer window.

To edit a file extension:

1. In the Configure Paths tab of your respective SchemaAgent application, select a file extension under
one of the sub-folders of the File extensions folder and do one of the following:

· Right-click and choose Edit file extension from the context menu.
· Press F2.
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The file extension name is selected for editing.

2. Edit the file extension name as required and press Enter. The  button appears
flashing red.

3. Click the Reload search paths button to display files with the changed file extension in the Explorer
window.

To delete a file extension:

1. In the Configure Paths tab of your respective SchemaAgent application, select a file extension under
one of the sub-folders of the File extensions folder and do one of the following:

· Right-click and choose Delete file extension from the context menu.
· Press Delete.

2. Click Yes in the message box that pops up. The  button appears flashing red.
3. Click the Reload search paths button to remove files with the deleted file extension from the Explorer

window.

1.4.3 Reloading Search Paths

The Reload search paths command updates and saves the currently defined search paths. It is necessary to
run this command if files have been changed outside SchemaAgent, or if the search path configuration has
changed (for example, when a new search path has been added). After a search path or file extension has been
added, edited, or deleted, an asterisk appears at the right of that search path or file extension and the Reload
Search Paths button is displayed at the bottom of the Configure Paths tab. This indicates that the search
paths need to be reloaded.

To reload search paths, do one of the following:

· In the Explorer window, click the Configure Paths tab, and then click Reload search paths.
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· Click the Reload search paths  toolbar button.
· On the Extras menu, click Reload search paths.

1.4.4 Resetting Search Paths

The Reset Search Paths command resets search paths to the settings with which they were last saved. This
is typically useful when you have made changes to the search path configuration (without reloading the search
paths yet) and would like to revert your changes for whatever reason.

To reset search paths:

1. In the Explorer window, click the Configure Paths tab.
2. Right-click anywhere inside window and select Reset search paths from the context menu.

1.4.5 Viewing the Configuration File

The set of supported files managed by LocalServer or SchemaAgent Server, respectively, is defined in an XML
file called SchemaAgentServerCfg.xml, which is by default stored in the Documents  folder.

This file defines the search paths, and what paths or folders are scanned for schema files. The
SchemaAgentServerCfg.xml file looks something like this:

8
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<?xml version="1.0" encoding="UTF-8"?>
<SearchPaths XMLSchema=".xsd" MapForce=".mfd" XML=".xbrl,.xml" XSL=".xsl,.xslt"

WSDL=".wsdl">

   <Path recursive="1" user="" auth="000000">s:\schemas-mydir\</Path>

   <Path recursive="0" user="" auth="000000">X:\schemas\</Path>

   <Path recursive="1" user="" auth="000000">http://test.webdav.org/dav</Path>

   <Path recursive="1" user="" auth="000000">\\Server1\Share1\Dir1\Schemadata</Path>

   <Path recursive="1" user="jsmith" auth="k04EKS">ftp://myftpserver</Path>

</SearchPaths>

Note that any number of search paths can be defined, and search paths can include paths on a local machine,
network paths (mapped drive letters and UNC paths), as well as folders on WebDAV servers and FTP access.

After search paths have been defined, LocalServer or SchemaAgent Server, respectively, retrieves all files with
defined file extensions in individual search paths and builds an internal map of the relationships between the
supported files in a search path. It is this mapping of relationships that enables SchemaAgent clients to
present data about file relationships graphically. Further, if an IIR or file manipulation change is made in a
SchemaAgent client, it is this mapping that enables the automatic updating of such changes in related files in
the search path.
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2 SchemaAgent Tutorial

This tutorial gives a short overview of W3C XML schemas and takes you through several tasks which provide an
overview of how to use SchemaAgent to its fullest. You will learn how to:

· Set up  SchemaAgent Client
· Create Include , Import , and Redefine  relationships between XML schemas
· Include , redefine , and import  a type
· Import a type using only XMLSpy
· View updated relationships
· View MapForce design  (.mfd) files

Installation and configuration
This tutorial assumes that you have successfully installed SchemaAgent on your computer and received a free
evaluation key-code, or are a registered user. The evaluation version of SchemaAgent is fully functional but
limited to a 30-day period. You can request a regular license from our secure web server or through any one of
our resellers.

Tutorial example files
The tutorial files are available in the
Documents\Altova\SchemaAgentLocalServer2025\SchemaAgentExamples\Tutorial folder. The parent
Examples folder contains various XML schemas for you to experiment with, while the Tutorial folder contains
all the files used in this tutorial. For each Windows user account, a separate Examples folder as well as a
configuration file  is created when the user runs SchemaAgent for the first time. This allows each user on the
computer to have separate SchemaAgent search paths and example files.

21
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2.1 Setting Up SchemaAgent Client

In this tutorial, we will work with the LocalServer that is automatically installed with SchemaAgent Client. You
must connect SchemaAgent Client to the LocalServer before you can use it to create relationships between
XML schemas.

In order to work with SchemaAgent, you must configure at least one path to a folder. Paths you configure are
stored on the SchemaAgent server (in this case, the LocalServer). Using SchemaAgent Client, you create
relationships between existing schemas in these paths. You can also create new skeleton XML schemas,
which can be completed later using XMLSpy.

Objective
In this section of the tutorial, you will learn how to connect to a server and define a search path. Specifically,
you will learn how to do the following:

· Start SchemaAgent Client and connect  to the LocalServer
· Configure a search path  to the folder that contains the examples for this tutorial

Commands used in this section
In this section of the tutorial, you will use the Explorer window exclusively. The following commands are used:

Icon Command name Description

Connect to Server This icon is located in the Extras toolbar. Click this icon to open
the Connect to SchemaAgent Server dialog box where you can
choose a server to connect to.

Add search path This command is included in the context menu that opens when
you right-click anywhere in the Configure Paths tab of the Explorer
window. Choose this command to add a new search path to the
current SchemaAgent server.

Reload search paths This icon is located in the Extras toolbar and also appears as a

 button at the bottom of the Explorer window
after changes occurred in the search paths.

2.1.1 Connecting to the LocalServer

When you install SchemaAgent Client, both the client and the LocalServer are installed. For the scope of this
tutorial, you will establish a connection to the LocalServer (as opposed to a server on the local network).

To connect to the LocalServer:

1. Do one of the following:

21

22
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· Double-click the SchemaAgent icon on your desktop.

· Click Start  and start typing "SchemaAgent" to access the program's shortcut.
· If the program is already running, select the menu option Extras | Connect to server or click the

Connect to Server  toolbar button from the Extras toolbar. The Connect to SchemaAgent
Server dialog box appears.

2. Choose Work locally and click OK.

2.1.2 Configuring a Search Path

In this section, you will configure a path to the folder that contains the files used in this tutorial. SchemaAgent
Client displays the search paths in the Hierarchical and Flat tabs of the Explorer window.

To configure a search path to the Tutorial folder:

1. In the Explorer window of SchemaAgent Client, click the Configure Paths tab.
2. Right-click any existing search paths added by default during installation, and select Delete Search

Path from the context menu.
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3. Right-click anywhere in the Explorer window and select Add search path from the context menu.
Alternatively, select the Search paths entry in the Explorer window and press the Insert key. The
Add/Edit search path dialog box opens.
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4. Choose Directory and select the Recursive check box to have the sub-folders displayed as well.
5. Using the directory tree from the lower part of the dialog box, navigate to the following directory:

Documents\Altova\SchemaAgent LocalServer2025\SchemaAgentExamples\Tutorial.
6. Optionally, if your paths are very long, select the Relative Path check box.
7. Click OK. The search path appears in the Explorer window.
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8. Click the Reload search paths button. When the operation completes, the asterisk next to "Search
paths" disappears, which indicates that the new search path is now saved.
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2.2 Creating Relationships Between XML Schemas

In this tutorial section, you will use SchemaAgent Client to create include, redefine, and import relationships
between schemas. Specifically, you will learn how to do the following:

· Show schemas  in the Design view of SchemaAgent Client
· Create an include relationship  between two schemas
· Create a redefine relationship  between two schemas
· Create an import relationship  between two schemas using different namespaces

Commands used in this section
In this section of the tutorial, you will use the Design window exclusively. The following commands are used:

Icon Command name Description

New (Ctrl+N) This icon is located in the Standard toolbar and it is also available
as an option in the File menu. Use this command to open a new
Design window.

2.2.1 Creating an Include Relationship

In this section, you will create an include relationship between the following schemas from the
SchemaAgentExamples\Tutorial\include_redefine folder:

· event_registration.xsd: This schema is structured to contain information about a participant who
registers for a sporting event. Because these events have fees, a type for containing credit card
information is also defined in this schema.

· dvd_order.xsd: This schema is structured to contain order details for mail order DVDs, and customer
shipping details.

The goal is to have dvd_order.xsd include types from event_registration.xsd, specifically those that store
customer and credit card data.

To display schemas in a Design window:

1. Select the menu option File | New, or click the New  icon, or press Ctrl+N to open a new Design
window.

2. In the Explorer window, click the Hierarchical tab.
3. Select event_registration.xsd and dvd_order.xsd from the "include_redefine" folder and drag them

into the Design window.
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Note: To drag and drop more than one file at the same time, click the files while holding down the Ctrl key.
Drag and drop a folder to put all the files it contains in the Design window.

To create an include relationship:

1. Click the small white triangle on the right side of event_registration.xsd and drag the connector line
to dvd_order.xsd.

2. Release the mouse button over the word "includes". A green arrow that points from
event_registration.xsd to dvd_order.xsd appears.

This arrow shows that an include relationship has been made between these schemas.
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2.2.2 Creating a Redefine Relationship

In this section, you will create a redefine relationship between the following schemas from the
SchemaAgentExamples\Tutorial\include_redefine folder:

· event_registration.xsd
· book_order.xsd: This schema is structured to contain order details for mail order books.

The goal is to have book_order.xsd include and redefine types from event_registration.xsd, specifically the
types for storing customer and credit card data.

Redefinition of schemas creates an implicit include relationship between the schemas and enables access to
all elements in the referenced schema. It allows you to redefine (i.e., restrict or extend) the individual
components of the referenced schema.

Note: In SchemaAgent Client, only the redefine relationship is created between the schemas. The actual
redefinition of individual components  can be done in XMLSpy.

To create a redefine relationship:

1. In the Explorer window, select book_order.xsd from the include_redefine folder and drag it into the
Design window that already contains the files event_registration.xsd and dvd_order.xsd.

2. Click the small green triangle on the right side of event_registration.xsd and drag the connector line
to book_order.xsd.

3. Release the mouse button over the word "redefines". A purple arrow that points from
event_registration.xsd to book_order.xsd appears. 

This arrow shows that a redefine relationship has been made between these schemas. Note that the
color of the triangle in the event_registration.xsd file box changed to indicate that relationships of
different types are existing with this file box.
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2.2.3 Creating an Import Relationship

The import relationship is used when you want to reuse components from one schema in a schema with a
different namespace. In this section, you will create an import relationship between the following schemas from
the SchemaAgentExamples\Tutorial\import folder:

· book_store.xsd: This schema is structured to contain the address of the book store, and details for
each book in the inventory.

· library.xsd: This schema is structured to contain the address of the library, and details (card catalog
number and whether the book is currently being borrowed) for each book in the library.

The goal is to have library.xsd import a type containing book information from book_store.xsd.

To create an import relationship:

1. Select the menu option File | New, or click the New  icon, or press Ctrl+N to open a new Design
window.

2. In the Explorer window, click the Hierarchical tab.
3. Select book_store.xsd and library.xsd from the "import" folder and drag them into the new Design

window.
4. Click the small white triangle on the right side of book_store.xsd and drag the connector line to

library.xsd.
5. Release the mouse button over the word "imports".

A blue arrow that points from book_store.xsd to library.xsd appears. This arrow shows that an import
relationship has been made between these schemas.
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2.3 Using XMLSpy as a SchemaAgent Client

In the previous sections of the tutorial, you have created include , import  and redefine  relationships
between schemas. When you create a relationship using SchemaAgent Client, the corresponding include,
import or redefine statement is automatically added to the XML schema.

In this section of this tutorial, you will learn how to use XMLSpy to do the actual including, importing and
redefining of individual components of the schemas. Specifically, you will learn how to do the following:

· Connect XMLSpy  to a SchemaAgent server
· Make elements of a content model into global complex types
· Include complex types  in a different schema
· Redefine types  in XMLSpy
· Import complex types  from schemas using different namespaces
· Include complex types directly in XMLSpy

Prerequisites
· Make sure that XMLSpy is installed.

Commands used in this section
In this section of the tutorial, you will use the Schema/WSDL View of XMLSpy exclusively. The following
commands are used:

Icon Command name Description

Connect to SchemaAgent
Server

This icon is located in the Schema design toolbar. Click this icon
to open the Connect to SchemaAgent Server dialog box where you
can choose a server to connect to.

Display Diagram (or
Display Content Model
View)

This icon is located to the left of all global components in Schema
Overview. Click this icon to display the content model of the
associated global component.

Make Global This command is included in the context menu that opens when
you right-click an element in the Content Model View. Use this
command to make this element into a new global element.

Add Child | Element This command is included in the context menu that opens when
you right-click a sequence element in the Content Model View. Use
this command to add a new child element to the content model.

Insert This icon is located at the top left-hand corner of the Schema
Overview. Clicking the icon enables you to insert a global
component before the selected element.

Display All Globals This icon is located at the top left-hand corner of the Content Model
View. Clicking the icon switches the view to Schema Overview,
which displays all global components. 
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2.3.1 Connecting XMLSpy to the LocalServer

The steps below illustrate how to connect XMLSpy as a client to the LocalServer. The SchemaAgent Client
application does not necessarily need to be open for this.

To open XMLSpy and connect to the SchemaAgent LocalServer:

1. Run SchemaAgent Client and click the Hierarchical tab in the Explorer window.
2. In the "include_redefine" folder, right-click event_registration.xsd and select Edit in XMLSpy

(Ctrl+Y) from the context menu.
3. In XMLSpy, select the menu option Schema design | Connect to SchemaAgent Server or click the

Connect to SchemaAgent Server  icon in the Schema design toolbar.

4. Select Work locally and click OK.
5. Click OK in the information window that pops up.

On successful connection, the message "Connected to local SchemaAgent Server" appears at the top of the
Schema Design window.

2.3.2 Making Elements into Global Complex Types

Creating IIR relationships makes the element of a schema available to other schemas. However, only global
elements can be used in other schemas. In this section of the tutorial, you will learn how to use XMLSpy to
make an element into a global complex type that can be included in different schemas.
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To make elements to be included global:

1. In SchemaAgent Client, right-click event_registration.xsd and select Edit in XMLSpy (Ctrl+Y) from
the context menu.

2. In XMLSpy, click the Display Diagram  icon for the element event_registration to display its
content model.

3. Right-click the personInfo element and select Make Global | Complex type from the context menu.
A new global complex type called personInfoType is created.

To display the "type" as shown in the screenshot above, proceed as follows:

a. Select the menu option Schema design | Configure View.
b. Click Predefined.
c. Click OK to confirm.

4. In the same way, make the creditCardInfo element into a global complex type. This results in a type
called creditCardInfoType.

5. Save the file.

2.3.3 Including Types

In this section, you will learn how add types from an included schema to a target schema. To this aim, you
have to open and edit the target schema, for example dvd_order.xsd, in XMLSpy.
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To include types into dvd_order.xsd:

1. In SchemaAgent Client, right-click dvd_order.xsd and select Edit in XMLSpy (Ctrl+Y) from the
context menu. Notice that the schema already contains an include statement, which was
automatically added when you connected the two schemas in the Include section  discussed
previously. The global complex types that you have created in the previous section of the tutorial are
now available in dvd_order.xsd.

2. In XMLSpy, click the Display Diagram  icon for the element dvd_order to display its content
model.

3. Right-click the sequence element and select Add child | Element.

4. Enter "customerInfo" as the name for this element.
5. With this element still selected, in the Details entry helper, select personInfoType from the "type"

drop-down list. 
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Note: The "type" list may contain items in black and blue color. Types in black are those available in the
current namespace. Types in blue are those available on the SchemaAgent's search path. If you cannot see
any items in blue, double-check that XMLSpy is connected to the SchemaAgent's LocalServer, as described in
Connecting XMLSpy to the LocalServer .

6. Using the same procedure, add a new element called "creditCardInfo" of type creditCardInfoType to
the sequence. The Schema view should now look as follows:

7. Save the file.

You have now included two types from the schema event_registration.xsd in the schema dvd_order.xsd.

2.3.4 Redefining Types

In this section, you will learn how to redefine a type from one schema in another schema. You will also learn
how to add a new element to a redefined type. This is also done in XMLSpy. For the purpose of this tutorial, we
will use the schema book_order.xsd as an example.

To redefine the type PersonInfoType:

1. In SchemaAgent Client, right-click book_order.xsd and select Edit in XMLSpy (Ctrl+Y) from the
context menu. 

Notice that the schema contains a redefine statement, which was automatically added when you
connected the two schemas in the Redefine section  discussed previously.

2. Select the line that says "end of redefine" and click Insert .
3. Select ComplexType from the menu that pops up and enter "personInfoType" as the name for this

type.
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4. Click the Display Diagram  icon for personInfoType. The content model of personInfoType, as
defined in event_registration.xsd, appears.

5. Right-click the  complexType, and select Add child | Sequence from the context
menu.

6. Right-click the new sequence icon and select Add Child | Element from the context menu.
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7. Enter "customerNumber" as the name for this element.
8. In the Details entry helper, select xs:string from the type drop-down list.

9. Save the file.

You have now redefined personInfoType to be used as a type in the XML schema book_order.xsd.
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2.3.5 Using Redefined Types

In the previous section, you redefined schema event_registration.xsd in schema book_order.xsd by adding
a customer number to the complex type personInfoType. In this section, you will learn how to use this
redefined complex type in schema book_order.xsd.

To use a redefined type in the target schema:

1. In the schema overview for book_order.xsd, click the Display Diagram  icon of the root element
book_order.

2. Right-click the sequence element and select Add child | Element from the context menu.

3. Enter "customerInfo" as the name for this element.
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4. With this element still selected, in the Details entry helper, select personInfoType from the type drop-
down list. 

The redefined type is now being used as the type of an element in book_order.xsd.

Using types without redefinition
Within a redefine relationship, you can also use types from the source schema without redefining them in the
target schema.

To use a type in the target schema as is:

1. In the display diagram for the element book_order, right-click the sequence element and select Add
child | Element from the context menu.

2. Enter "creditCardInfo" as the name for this element.
3. With this element still selected, in the Details entry helper, select creditCardInfoType from the type

drop-down list. 
4. Save the file. The type creditCardInfoType is now being used as the type of an element in

book_order.xsd.



© 2019-2025 Altova GmbH

Using XMLSpy as a SchemaAgent Client 39SchemaAgent Tutorial

Altova SchemaAgent 2025

2.3.6 Importing Types

The tutorial schemas book_store.xsd and library.xsd have different target namespaces. You can easily view
this if you drag both schemas from the "import" folder into the main SchemaAgent window and expand their
namespaces:

According to the diagram above:

· The schema book_store.xsd has the target namespace
http://www.xmlspy.com/schemas/orgchart. This is also the default namespace. The prefix xsd is
mapped to the namespace http://www.w3.org/2001/XMLSchema.

· The schema library.xsd has the target namespace http://www.altova.com/IPO. This is also the
default namespace. The prefix xs is mapped to the namespace
http://www.w3.org/2001/XMLSchema. The prefix ns1 is mapped to the namespace
http://www.xmlspy.com/schemas/orgchart.

Let's suppose that, while working with the library.xsd schema, you need the type bookType from the
namespace http://www.xmlspy.com/schemas/orgchart (which is the target namespace of
book_store.xsd). To combine schema documents that have different target namespaces like in this case, an
import relationship must be used. The import relationship between the two schemas has already been added in
a previous step of the tutorial, see Creating an Import Relationship . In this part of the tutorial, you will be
using a type from the imported namespace. First, you will turn the local type bookType into a global complex
type. Once this is done, you will be able to declare a new element of this type in the library.xsd schema.

To turn the "book" component into a global complex type:

1. In SchemaAgent Client, right-click book_store.xsd and select Edit in XMLSpy (Ctrl+Y) from the
context menu.
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2. In XMLSpy, click the Display Diagram  icon for the element book_store to display its content
model.

3. Click the "+" icon to expand the bookInfo element.

4. Right-click the book element and select Make Global | Complex type from the context menu.
5. Save the file.

To import bookType to library.xsd:

1. In SchemaAgent Client, right-click library.xsd and select Edit in XMLSpy (Ctrl+Y) from the context
menu.

2. In XMLSpy, click the Display Diagram  icon for the element library to show its content model.

3. Click the "+" icon to expand the bookInfo element.

4. Right-click the sequence icon after the bookInfo element and select Add child | Element from the
context menu.

5. Enter "bookDetails" as the name for the element.
6. With this element still selected, in the Details entry helper, select ns1:bookType from the type drop-

down list. 
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7. Save and close the file. 

You have now imported a type from the schema book_store.xsd into the schema library.xsd.

2.3.7 Including Types Using Only XMLSpy

In the previous sections, you have created include, import and redefine relationships in SchemaAgent, and then
worked with the included, imported or redefined types in XMLSpy. In this section, you will create include
relationships using only XMLSpy, as a client to SchemaAgent LocalServer.

The following schema examples will be used:

· company1.xsd: This schema is structured to contain information about a company and its
employees.

· company2.xsd: This schema is structured to contain information about the products of a company.

The goal is to include the address and employee components from company1.xsd in company2.xsd. Both
schemas are in the SchemaAgentExamples\Tutorial\include2 folder.

To make the components to be included into global complex types:

1. Open company1.xsd in XMLSpy. 
2. Make sure that you are connected  to the SchemaAgent LocalServer.

3. In XMLSpy, click the Display Diagram  icon for the root element company1 to display its content
model.
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4. Right-click the address element and select Make Global | Complex type from the context menu. A
new global complex type called addressType is created.

5. Click the "+" icon to expand the employees element.

6. In the same way, make the employeeData element into a global complex type. This results in a type
called employeeDataType.

7. Save the file.

To include global complex types in schemas using XMLSpy:

1. Open the target schema company2.xsd in XMLSpy.
2. Make sure that you are connected  to the SchemaAgent LocalServer.

3. In XMLSpy, click the Display Diagram  icon for the root element company2 to display its content
model.

4. Right-click the sequence element and select Add child | Element from the context menu.
5. Enter "companyAddress" as the name for this element.
6. With this element still selected, in the Details entry helper, select addressType from the type drop-

down list. The type "addressType" is in blue because it is on the SchemaAgent search path.
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7. A dialog box opens where you can select which type of relationship you want to have between the two
schemas. 

8. Select Include and confirm with OK. This inserts an include statement into the company2.xsd
schema.

9. Repeat steps 4 to 65 to create a further element with the name "employee" and of type
employeeDataType. Notice that, when you select employeeDataType from the type drop-down list in
the Details entry helper, it is in black, because there is now an include relationship between the
schemas.

10.  Save the file.

You have now included two types from the schema company1.xsd in the schema company2.xsd.
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To view the include statement that has been inserted:

· Click the Display All Globals  icon.
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2.4 Viewing the Updated Relationships

You can now view the include and redefine relationships that you created between schemas in the course of
this tutorial, for example:

1. In SchemaAgent Client, select the File | New menu command, or click the New  toolbar button,
or press Ctrl+N, to open a new Design window.

2. In the Explorer window, click the Hierarchical tab.
3. Drag the following files from the include_redefine folder into the Design window:

event_registration.xsd, dvd_order.xsd, and book_order.xsd.
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To view details about a specific section in each schema, click the expand  icon. To move a schema, click
its title bar and drag the mouse to a new position. To resize the component, drag its lower-right corner , or
right-click anywhere inside the component and select Size to fit from the context menu.

To display information about a specific file on the Design window, position the cursor over the title bar. A Quick
Info box displays information about that file.
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2.5 Viewing MapForce Design Files

MapForce (https://www.altova.com/mapforce) is a data mapping tool that lets you convert data to or from
multiple formats, including but not limited to XML. The data mappings designed with MapForce are known as
MapForce design files (.mfd), or simply mappings. This tutorial section shows you how to use SchemaAgent
Client in order to examine MapForce design files.

To view MapForce design files in SchemaAgent:

1. In SchemaAgent Client, select the File | New menu command, or click the New  toolbar button,
or press Ctrl+N, to open a new Design window.

2. In the Explorer window, select ExpenseLimit.mfd, HasMarketingExpenses.mfd,
MarketingAndDailyExpenses.mfd, and MarketingExpenses.mfd from the MapForce folder and drag
them into the Design window.

3. Right-click each of the files and select Insert | All directly referenced | Files from the context menu.
The related XML schemas and their relationships appear in the Design window.

4. Click the expand  icon of each of the .mfd files. Now you can see the inputs and outputs of each
mapping design file. You can further expand the input or output schemas and explore the structure.

https://www.altova.com/mapforce
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5. To resize a component, drag its lower-right corner , or right-click anywhere inside the component
and select Size to fit from the context menu.



© 2019-2025 Altova GmbH

 49SchemaAgent Server

Altova SchemaAgent 2025

3 SchemaAgent Server

SchemaAgent Server processes client requests to create, update, or delete schema IIRs (Includes, Imports,
and Redefines) and references between schemas and supported files, and manages the communication
between SchemaAgent Server and its clients.

SchemaAgent Server reads information about the supported files in a folder you identify (and optionally in that
folder's subfolders)—the search path. You can define multiple search paths; the configuration instructions are
identical on the server and client, see Adding or Editing Search Paths . SchemaAgent Server determines the
relationships between files on the search path and creates an internal map of these files and their components.

Once the search paths are defined on the server, you can view and administer the relationships between files in
the defined search paths from within the graphical user interface of any connected client.

If a folder that is in a search path has its structure modified outside SchemaAgent Server (for example, if a
folder is deleted from Windows Explorer), then this information is not updated in SchemaAgent Server until
search paths are reloaded .

 SchemaAgent Server and its clients transfer data using UDP and TCP over port 2799.
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3.1 Installing SchemaAgent Server

The SchemaAgent Server installation package can be downloaded free of charge from the SchemaAgent
download page (https://www.altova.com/schemaagent/download).

To install SchemaAgent Server:

1. Double-click the SchemaAgent Server installer file.
2. Follow the on-screen instructions. During installation, a dialog box prompts you to choose whether

SchemaAgent Server should be installed as a standalone server, or a service. Each of these options is
described below.

3. If necessary, start the server (see Starting SchemaAgent Server ).

Installing SchemaAgent Server as standalone server
When installed as a standalone server, SchemaAgent Server can be started as a standard Windows

application, from the Start  menu. When the server is started, an application icon  appears in the system
tray. In this approach, the application has a graphical user interface from where you can configure the search
paths  and other settings. This kind of installation is well suited if you need to access the graphical user
interface frequently (for example, in order to change the search paths).

Installing SchemaAgent Server as a service
When installed as a service,  SchemaAgent Server is available as a service in Control Panel | Administrative
Tools | Services, and can be managed in the same way as other Windows services. The advantage is that it
can be configured to start automatically when the system starts (this option is also available on the installation

53
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wizard). Installing SchemaAgent Server as a service is suitable when it must act as a network server for
multiple clients. 

Note that, in this scenario, SchemaAgent Server does not have a graphical user interface and cannot be started

from the Start  menu or from a desktop shortcut. Also, no system tray icon is available. In order to configure
SchemaAgent Server (that is, define search paths), you must first install SchemaAgent Server as a standalone
server, configure it, and then change the installation method from the command line (see instructions below).

Changing the installation type
If you want to change the installation model (from standalone to service, or vice versa) after you have installed
the program, you can do so by calling SchemaAgentServer.exe using the command line. Otherwise, you
would have to uninstall SchemaAgent Server and reinstall it choosing a different installation method.

The commands listed below are available when calling SchemaAgentServer.exe from the command line. The
executable always returns a return code when run in command-line mode. If an error is encountered using the -
install and -remove parameters, then the returned error code is identical to the code supplied by the
operating system.

No command line parameters Start as standalone application.

 /install or -install Install as a service.

 /remove or -remove Uninstalls the service.

 /quiet or -quiet Suppresses message boxes that appear when an error 
occurs using the Install or Remove commands.

To change the installation type from "standalone" to "service":

1. Ensure that SchemaAgent Server is not running. To exit a running SchemaAgent Server, right-click the

Altova SchemaAgent Server  application icon in the system tray and select Shutdown from the
context menu.

2. Open a Command Prompt window (as administrator), and change the current directory to the
installation folder of SchemaAgent Server (C:\Program Files\Altova\SchemaAgentServer2025 by
default).

3. At the command prompt, enter SchemaAgentServer.exe /install to install SchemaAgent Server as
a service.

4. Start SchemaAgent Server as a service (see Starting SchemaAgent Server ).

To change the installation type from "service" to "standalone":

1. Ensure that SchemaAgent Server is not running. To exit a running SchemaAgent Server service, open
Control Panel | Administrative Tools | Services, right-click the SchemaAgent Server Service and
choose Stop from the context menu.

2. Open a Command Prompt window (as administrator), and change the current directory to the
installation folder of SchemaAgent Server (C:\Program Files\Altova\SchemaAgentServer2025 by
default).

3. At the command prompt, enter SchemaAgentServer.exe /remove to uninstall the existing
SchemaAgent Server service.
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4. At the command prompt, enter SchemaAgentServer.exe to start the standalone installation.
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3.2 Starting SchemaAgent Server

If you have installed SchemaAgent Server as a standalone server, you must start the server application before
SchemaAgent Client can connect to it. If you have installed SchemaAgent Server as a service, it may already
be running, depending on the option you specified during installation. See also Installing SchemaAgent
Server .

Note: Only one instance of SchemaAgent Server can be started at a time. If you try to start SchemaAgent
Server when it is already running, an error message appears.

To check whether SchemaAgent Server is already running as a service:

1. Open Control Panel | Administrative Tools | Services.
2. Locate the SchemaAgent Server Service in the list and check its status.

To start SchemaAgent Server as standalone server:

· Click Start , and then select Altova SchemaAgent Server 2025 | Altova SchemaAgent Server.

To start SchemaAgent Server as a service:

1. Open Control Panel | Administrative Tools | Services.
2. Right-click the SchemaAgent Server Service and select Start.
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3.3 Hiding SchemaAgent Server

After you have configured the search paths  and the file extensions  of a standalone SchemaAgent Server,
you can either reconfigure it to run as a service and thus make it completely unavailable to the users, or hide
the application in the system tray.

To hide SchemaAgent Server in the system tray:

· Right-click the Altova SchemaAgent Server  application icon in the system tray and select Hide
from the context menu.

To show SchemaAgent Server when hidden in the system tray, do one of the following:

· Right-click the Altova SchemaAgent Server  application icon in the system tray and click to clear
the Hide option.

· Double-click the application icon in the system tray.

13 16
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3.4 Exiting SchemaAgent Server

If SchemaAgent Server runs as a standalone server, you can exit it using the instructions below. If
SchemaAgent Server runs as a service, you can stop it from Control Panel | Administrative Tools |
Services instead.

Please note that if you exit SchemaAgent Server while clients are still connected, these clients will lose their
connection to SchemaAgent Server and thus will not be able to process commands that depend on a
connection to SchemaAgent Server (e.g., commands such as creating or modifying an IIR relationship in a
SchemaAgent design). Therefore, a dialog box appears in this case, displaying the number of currently
connected clients and asking whether shutdown should be continued.

To exit SchemaAgent Server, do one of the following:

· In the SchemaAgent Server GUI, select the menu option File | Shutdown.

· Right-click the Altova SchemaAgent Server  application icon in the system tray and select
Shutdown from the context menu.
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3.5 The SchemaAgent Server User Interface

The graphical user interface is available if you have installed SchemaAgent Server as a standalone server, see
Installing SchemaAgent Server . If you have installed and started SchemaAgent Server as a service, no
graphical user interface is available. The user interface is organized as follows:

· The Environment window provides you with information about search paths and files available herein.
· The Main window shows the currently defined search paths.
· The Log window shows client requests, server responses, and other server-related data.

You can dock or undock the Environment and the Log windows to a new position, as follows:

1. Click the window's title bar and drag the mouse. Several docking helpers appear.

2. Drag the window over a top, right, left, or bottom handle to dock it to the new position.

To show or hide a window, select the respective option from the View menu.

Environment window
The Clients tab displays details about the clients that are currently connected to SchemaAgent Server.
Connections to SchemaAgent Server are initiated by a request from the client, and must be made from the
client.
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The screenshot above shows that two clients, SchemaAgent Client and XMLSpy, are currently connected to
SchemaAgent Server. The IP addresses of the connected clients are also listed. The number of requests made
by a client is shown in the RQs column, and the time of the last request made by each client is shown in the
LastRQ column.

The Configure Paths tab displays the search paths as well as the file extensions of the files the paths are
searched for. For more information, see Configuring Search Paths .

Log window
The Log window shows client requests, server responses, and other server-related data. This data is presented
as a description, together with the time of execution (in the case of actions) or the time of data transfer (in the
case of notifications). When the information involves a client, the client is listed together with its IP address. 

The following symbols may appear in the Log window:

Requests from the client (blue, right-pointing arrow)

Responses from the server (green, left-pointing arrow)

Information regarding connection or disconnection of a client

The source client (of requests) and target client (for responses) are indicated in the Source/Target column.
The Parameters/Description column shows the kind of action, while the Time column gives the time of the
action.

Each time a search path is modified in SchemaAgent Server (for example, if the Recursive option is disabled
for a search path), the modified file structure is sent by SchemaAgent Server to all connected clients.

If a folder that is in a search path has its structure modified outside SchemaAgent Server (for example, if a
folder is deleted from Windows Explorer), then this information is not updated in SchemaAgent Server until
search paths are reloaded .

The message "Failed to read <file type> file" appears when a file includes or imports other files which cannot
be found at the location specified.
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3.6 Configuring the Server

The SchemaAgent Server options you can configure are as follows:

1. The search paths and extensions of monitored files. The instructions are the same as for the
SchemaAgent Client, see Configuring Search Paths .

2. The logging options.

Setting the logging options
You can optionally configure whether the information displayed in the Log window should be written to a log file.

To configure the logging options:

1. On the Settings menu, click Logging Options. The Logging Options dialog box opens.

2. Optionally, click Select All or Clear All to select, or clear, respectively, all check boxes.

The available options are listed below.

Log window active Select this check box if SchemaAgent Server actions should be displayed in
the Log window. 

Max. lines Specifies the maximum number of lines visible in the Log window.

Log input Enables or disables the display of incoming requests.

Log output Enables or disables the display of outgoing responses.

Log internals Enables or disables the display of internal SchemaAgent Server information.

Logfile active Select this check box if SchemaAgent Server actions should be written to a log
file. The log file is a Comma Separated Values (CSV) file named
SchemaAgentServerLog.csv and is created in the same folder as
SchemaAgent Server each time you start a SchemaAgent Server session.

12
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The Log input, Log output, and Log internals check boxes let you specify
whether these categories of data are written to the log file.
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3.7 Menu Reference

This chapter provides reference to all SchemaAgent Server menu commands. 

3.7.1 File Menu

The File | Shutdown command exits SchemaAgent Server, see Exiting SchemaAgent Server .

3.7.2 View Menu

The View | Environment command shows or hides the Environment window.

The View | Log command shows or hides the Log window.

3.7.3 Settings Menu

The Settings | Logging Options... command opens the SchemaAgent Server Logging Options dialog box, see
Setting the Logging Options .

3.7.4 Help Menu

The Help menu contains commands required to get help or more information on SchemaAgent, as well as links
to information and support pages on our web server.

Help
The Help (F1) command opens the application's Help documentation (its user manual). By default, the Online
Help in HTML format at the Altova website will be opened.

If you do not have Internet access or do not want, for some other reason, to access the Online Help, you can
use the locally stored version of the user manual. The local version is a PDF file named Application.pdf that

is stored in the application folder (in the Program Files folder).

If you want to change the default format to open (Online Help or local PDF), do this in the Help section of the
Options dialog (menu command Tools | Options).

Support Center
This command provides links to the FAQs, online documentation, and the support form for contacting Altova
support.

FAQ on the Web
Same as above.
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SchemaAgent Server on the Internet
This command opens the Altova website in a browser window, where you can find out about news, product
updates and additional offers from the Altova team.

About SchemaAgent Server
This command displays copyright information and the version of SchemaAgent Server. If you are using the 64-
bit version of SchemaAgent, this is indicated with the suffix (x64) after the application name. There is no suffix
for the 32-bit version.
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4 SchemaAgent Client

SchemaAgent Client enables you to create or modify IIR relationships (Imports, Includes, and Redefines)
between schemas as well as relations between any of the supported file types.

In a SchemaAgent design, you can also view relationships  between schemas and between a schema-based
MapForce design file (.mfd) and its associated schemas. Furthermore, you can display XSLT stylesheets and
WSDL files and view the relations these files have with schema files, XML instances, and .mfd files.
SchemaAgent designs can be saved to the disk for later editing.

Additionally, SchemaAgent Client enables you to manage schemas and their associated files (rename ,
move, delete , and so on) so that references to files that have been modified in this way are globally updated
in related files. This functionality makes SchemaAgent Client a powerful workspace from which to manage large
numbers of complex, related schemas, and edit relationships between these schemas and any of the other
supported files that are linked to them in any form.

SchemaAgent Client connects to a SchemaAgent server . It can either connect to the LocalServer  that is
installed in the same executable, or connect to a standalone SchemaAgent Server . The main difference
between these two servers is that LocalServer is installed on the local machine and serves clients on the same
computer, while SchemaAgent Server can be installed on a network machine, serves multiple clients, and
provides detailed logging information.

After connecting to the server, SchemaAgent Client retrieves information about the monitored files in the
respective server's search paths , and displays the folders in the search paths as a tree structure
(hierarchical and flat) in the Explorer window  of SchemaAgent Client. In SchemaAgent Client, you then drag
files from the tree  and drop them into the SchemaAgent design in the Design window .

In the Design window, you can view the composition of schemas and their associated files, and build
relationships between supported files. When you build or modify a relationship between two schemas, not only
are the actual schema files updated with the new information, but all other linked schemas affected by the
relationship are also updated.
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4.1 Installing SchemaAgent Client

You can download the  SchemaAgent installation package from the SchemaAgent download page
(https://www.altova.com/schemaagent/download). If you have purchased Altova® MissionKit™, the
SchemaAgent Client is included in the package.

To install SchemaAgent Client, double-click the installer file to run the installation process, and then follow the
wizard steps. During the installation process, you will be asked whether you wish to use SchemaAgent locally
(by connecting to the LocalServer installed on the current computer together with the client) or connect to an
existing SchemaAgent Server. 

If you choose Select a ShemaAgent Server, you can select from the list any instances of SchemaAgent
Server that were previously installed on computers on the local network, see Installing SchemaAgent Server
. You can change your preference at any time later, by running the menu command Extras | Connect to
Server.

50
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4.2 Starting SchemaAgent Client

To start SchemaAgent Client, do one of the following:

· Double-click the SchemaAgent icon on your desktop.

· Click Start  and start typing "SchemaAgent" to access the program's shortcut.

When prompted to connect to a server, you have the following options:

· Work Locally. Choose this option to start a local server and connect to it. In this approach, you can
start configuring the search paths immediately, from the Explorer window. Note that, since the server
runs locally, no other SchemaAgent clients can connect to it.

· Connect to a network server. Choose this option to connect to a previously installed SchemaAgent
Server on the local network. The SchemaAgent Server must be running in order to appear in the list. In
this approach, you must configure the search paths on the server. Any clients connected to the server
are able to view and manage files on the search path.

See also Connecting to a Server .70
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4.3 The SchemaAgent Client User Interface

The graphical interface of SchemaAgent Client is organized into the following broad parts:

· Explorer window , which provides you with information about search paths and files available herein.
· Overview window , which shows what part of the active design is currently in view in the main

window.
· Design window , which graphically displays the structure of the supported file types, and shows

existing Includes, Imports, Redefines (IIRs) between schemas, or relationships between any of the
supported files, respectively.

To dock or undock a window, do one of the following:

· Right-click the window's title bar, and select Docking (or Floating, respectively) from the context
menu.

· Click the arrowhead  button in the upper-right corner of the window and select Docking (or
Floating, respectively) from the context menu.

· Double-click the title bar of a window to toggle it between its docked and floating positions.
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To dock a window to a new position:

1. Click the window's title bar and drag to a new position. Several docking helpers appear.

2. Drag the window over a top, right, left, or bottom handle to dock it to the new position.

To restore toolbars and windows to their default state:

· Run the menu command Tools | Restore Toolbars and Windows. 

4.3.1 Explorer Window

The Explorer window displays all search paths defined for the selected SchemaAgent Server as well as the
relevant files contained herein. Depending on your installation, these search paths can be configured directly in
the Configure Paths tab (if you are connected to a LocalServer) or in SchemaAgent Server (if you are
connected to a network-based server). Consequently, the Configure Paths tab is visible only if you are
connected to a LocalServer.

Hierarchical Tab
The Hierarchical tab shows all the defined search paths and their contents. Folders that contain supported file
types  have the standard Windows appearance. Folders that contain no such files are slightly opaque, like
the Import folder in the image below.

To hide folders that contain no supported files, right-click inside the window and select Show Empty Folders
from the context menu.

16
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Flat Tab
The Flat tab displays a flat list of all monitored files in all search paths, as well as all schemas from the
External files folder (that is, schemas referenced by schemas in the search paths, but which are not
themselves in any search path), if such schemas exist. Each file entry is displayed with its location and its
status.

In the screenshot above, note the different icons used to indicate ghost files   and files with unresolved

relations  .

4.3.2 Overview Window

The Overview window serves as a navigator for big design files that occupy more space than is available in the
Design window. The Overview window shows the currently displayed area in the design and you can move the
focus by clicking into the rectangle and moving it to the desired location in the design file.
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4.3.3 Design Window

The Design window is where you view and edit the files for which you have defined the relevant file
extensions .

You can drag files from the Explorer window and drop it onto the Design window to get a graphical
representation of the files and their existing Includes, Imports, and Redefines (IIRs). The files can be aligned
and sorted  according to your needs, or removed  from the design again. It is possible to recreate a
deleted file  and to correct reference paths  to files that are not existing on the specified location.

Includes, Imports, and Redefines between schemas or schemas and .mfd files, respectively, are illustrated with
customizable colored lines. IIRs can be edited  and added  using drag-and-drop and you can save
each design for later use. 

You can create or open multiple Design windows. Use the commands in the Window menu to arrange the
windows or bring a specific window in foreground.

4.3.4 Menu Bar, Toolbars, and Status Bar

The menu bar contains the various application menus. The following conventions apply:

· If commands in a menu are not applicable, they are unavailable (grayed out).
· Some menu commands pop up a sub-menu with a list of additional options. Menu commands with

sub-menus are indicated with a right-pointing arrowhead to the right of the command name.
· Some menu commands pop up a dialog that prompts you for further information required to carry out

the selected command. Such commands are indicated with an ellipsis (...) after the name of the
command.
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· To access a menu command, click the menu name and then the command. If a sub-menu is indicated
for a menu item, the submenu opens when you move the mouse pointer over the menu item. Click the
required sub-menu item.

· A menu can be opened from the keyboard by pressing the appropriate key combination. The key
combination for each menu is Alt+KEY, where KEY is the underlined letter in the menu name. For
example, the key combination for the File menu is Alt+F.

· A menu command (that is, a command in a menu) can be selected by sequentially selecting (i) the
menu with its key combination (see previous point), and then (ii) the key for the specific command
(where KEY is the underlined letter in the command name). For example, to open a file (File | Open),
press Alt+F and then O.

· Some menu commands can be selected directly by pressing a special shortcut key or key
combination (Ctrl+KEY). Commands which have shortcuts associated with them are indicated with the
shortcut key or key combination listed to the right of the command. For example, you can use the
shortcut key combination Ctrl+N to create a new file; the shortcut key F2 to rename a file or folder in
the Explorer window.

Toolbars
The toolbars contain buttons that are shortcuts for commands found in the menus. The name of the command
appears when you place your mouse pointer over the button. To execute the command, click the button.

Toolbar buttons are arranged in groups. In the Tools | Customize | Toolbars  dialog, or when right-clicking
into the toolbar and selecting Customize, you can specify which toolbar groups are to be displayed. In the
GUI, you can also drag toolbar groups by their handles (or title bars) to alternative locations on the screen.
Double-clicking the handle causes the toolbar to undock and to float; double-clicking its title bar causes the
toolbar to dock at its previous location.

Status Bar
The Status Bar is located at the bottom of the application window and displays (i) status information
(application version, license status, copyright year), and (ii) information about menu commands and command
shortcuts in the toolbars when the mouse cursor is placed over these. If you are using the 64-bit version of
SchemaAgent, this is indicated in the status bar with the suffix (x64) after the application name. There is no
suffix for the 32-bit version.
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4.4 Connecting to a Server

In order to use SchemaAgent Client, you must connect the application to a server first. When you start

SchemaAgent Client, the  icon is displayed in the upper right corner of the application and the
Connect to SchemaAgent Server dialog box pops up.

You have two options to use SchemaAgent Client:

· Work locally : This will start a standalone LocalServer on your PC which you can configure from
within SchemaAgent Client

· Connect to network server : This will connect to a network-based SchemaAgent Server which must
already be running and allows for several users being connected. To configure SchemaAgent Server,
you have to open the server application and this configuration is available to all connected clients.

If a SchemaAgent server connection already exists, you have to close this connection before making a new
connection.

To connect to a server:

1. Select the menu option Tools | Connect to Server or click the Connect to Server  toolbar
button. The Connect to SchemaAgent Server dialog box opens.

2. Do one of the following:

· Select Work locally to start and connect to the standalone LocalServer. Once the local server
starts, you can configure search paths from the Configure Paths tab in the Explorer window.

· Select Connect to network server and choose a SchemaAgent Server to connect to from the drop-
down list. After a successful connection is made, the search paths defined on the server are
displayed in the Explorer window.

3. Click OK.
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To close a connection:

· Click the SchemaAgent server  icon in the system tray (at the bottom right of your screen) and
select the Shutdown command.

4.4.1 Working Locally

If you choose to connect to your local standalone server, the LocalServer starts automatically and the

Configure Paths tab is added to the Explorer window. The  icon is displayed in the upper-right

corner of the application and the system tray shows the LocalServer  icon.

You can configure LocalServer to start automatically each time you log into Windows, as follows:

1. On the Tools menu, click Options.
2. Click the Miscellaneous tab.
3. Select the Startup during user login (Add to Startup folder) check box.
4. Click OK.

To shut down the LocalServer:

· Click the LocalServer  icon in the system tray (at the bottom right of your screen) and select
Shutdown SchemaAgent LocalServer.

4.4.2 Connecting to a Network Server

 If you have set up a network server you wish to connect to, select the Connect to network server option and
choose the appropriate server from the drop-down list. Note that the server must already be running in order for
SchemaAgent Client to be able to connect to, see Starting SchemaAgent Server . 

On successful connection, the  icon is displayed in the upper-right corner of the application and indicates
the name of the server you are connected to. The search paths can be configured directly in SchemaAgent
Server and are valid for all connected clients. Therefore, no Configure Paths tab is available in the Explorer
window.
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4.5 Managing Files and Folders

The Hierarchical and Flat tabs of the Explorer window show all the defined search paths  as well as the
files with the defined file extensions . In the Hierarchical tab, you can create , rename  or delete
files or folders. Also, you can move files and folders to other positions under each path entry and recreate ghost
files .

All of the actions in the Explorer window are performed by means of the context menu or by using drag-and-
drop. The content of the context menu depends on the file, folder, or area from where it is called. The following
context menu commands appear if you right-click anywhere into the blank area within the Explorer window:

· Show Empty Folders: This command toggles on and off the display of folders that do not contain any
files with file extensions defined in the Configure Paths tab.

· Add search path: This command is only available if you are connected to the LocalServer. It changes
to the Configure Paths tab and opens a dialog box where you can define the settings for a new
search path.

If you right-click a file or folder, the following context menu commands may appear:

· Rename (F2): Renames  the selected file or folder.
· Delete (Delete): Deletes  the selected file or folder from the file system.
· New: This command is available for folders. It opens a sub-menu from where you can choose to create

a new file or folder .
· Reload: Reloads the selected file from the disk. You can also select several files and run the Reload

command to reload the files in one single step.
· Recreate: This command is available only if you have selected at least one ghost file. It creates a new

rudimentary file  with the name of the ghost file.
· Correct reference paths (Ctrl+R): This command is available only if you have selected at least one

file with a reference to a ghost file. It opens a dialog box where you can search for the ghost file in
different locations.

· Synchronize Selection: If you have a design open in the Design window, this command selects the
same files in the Design window that are selected in the Explorer window.

· Edit files in MapForce (Ctrl+M): Opens the selected .mfd file in MapForce for editing (provided that
you have installed MapForce).

· Edit files in XMLSpy (Ctrl+Y): Opens the selected file in XMLSpy for editing (provided that you have
installed XMLSpy).

· Insert files into clipboard (Ctrl+C): Copies the selected files to the clipboard so that you can paste
them into a Design window.

· Insert files into current design (Insert): Adds the selected files to the design that is currently open in
the Design window.

Any change made in the Hierarchical and Flat tabs (such as renaming or deleting files, or changing the
include, import, or redefine relationships) automatically affects any file referencing the changed file. Since
there is no Undo command available for these actions, it is highly recommended that you have a working
backup system or use source control software when working with SchemaAgent Client.
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4.5.1 Creating Files and Folders

To create a new file or folder in the Explorer window:

1. In the Hierarchical tab, select the folder where you want to create the file or folder.
2. Right-click and select one of the following commands from the context menu, as applicable:

· New | Schema
· New | XML file
· New | XSL file
· New | WSDL 1.1 file
· New | WSDL 2.0 file
· New | MapForce design
· New | Folder

If you chose to create a new file, a rudimentary "untitled" file having the respective file extension is
created. If you chose to create a folder, a new empty folder called "new folder" is created.

3. Enter a descriptive name and press Enter.

If you open a new schema in XMLSpy, it will look like this:

A new XML file has the following content:

A new XSLT file will look like this:

A file with the following content is created if you choose to add a new WSDL 1.1 file:



74 SchemaAgent Client Managing Files and Folders

© 2019-2025 Altova GmbHAltova SchemaAgent 2025

A file with the following content is created if you choose to add a new WSDL 2.0 file:

4.5.2 Renaming Files and Folders

When you rename a file in the Explorer window, SchemaAgent automatically corrects any references to the
changed name and updates the display in the Design window if the renamed item is contained in the currently
open design.

Note: Although you can change the file extension when renaming files, this will not change the file type and the
file may become unusable. SchemaAgent displays a warning if you are about to change the file extension.

To rename a file or folder:

1. In the Explorer window, select the file or folder and do one of the following:

· Right-click and select Rename from the context menu.
· Press F2.

2. Change the name as desired. Any references to the changed name are automatically updated.
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4.5.3 Deleting Files and Folders

You can delete files or folders on the disk from the Explorer window.

Note: Deleted files are not placed in the Windows Recycle Bin, and this step cannot be undone.

If the deleted file is present in a Design window, it is represented as an unknown file and receives a yellow alert
icon.

To delete a file or folder:

1. In the Explorer window, select a file or folder and do one of the following:

· Right-click and select Delete from the context menu.
· Press the Delete key.

2. Click Yes in the message box to confirm the deletion.

4.5.4 Editing Files

Apart from the definition of Includes, Imports, and Redefines, files cannot be directly edited in SchemaAgent.
However, the context menus of the Explorer window and the Design window provide options to edit the selected
files in XMLSpy or MapForce. These options are available only if the respective programs are installed on your
computer.

To edit a file in XMLSpy:

· In the Design window or in the Explorer window, select the file you want to edit and do one of the
following:

· Right-click and select Edit in XMLSpy from the context menu.
· Press Ctrl+Y.

To edit an .mfd file in MapForce:

· In the Design window or in the Explorer window, select the MFD file you want to edit and do one of the
following:

· Right-click and select Edit in MapForce from the context menu.
· Press Ctrl+M.
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4.6 Viewing Files in the Design Window

The Design window offers several grid and zoom options that can be configured to facilitate an optimal display
of XML schemas , MapForce Design files , XML files , XSL/XSLT stylesheets , WSDL files , and
IIR relations .

Showing or hiding the grid
Displaying the grid in the design window can serve as an aide for properly aligning the file boxes. You can
toggle the grid display on and off separately for each individual Design window.

To toggle the grid in a SchemaAgent Design window on and off:

Do one of the following:

· Select the menu command Layout | Show Grid.
· Right-click an empty area in the Design window and select Show Grid from the context menu.
· Press Alt+G.

· Click the Enable/Disable grid  toolbar button.

To enable or disable the grid globally at application level:

1. On the Tools menu, click Options.
2. Select or clear the Enable grid by default option.

Aligning file boxes on grid
When the grid is displayed, you can align the top and left edges of file boxes on the grid.

To align file boxes on the grid:

1. Turn the grid display on if it is not currently displayed (see above).
2. Select the file boxes you want to align.
3. Do one of the following:

· Select the menu command Layout | Align on Grid.

· Click the Align on Grid  toolbar button.

To align a specific file box only, right-click the title bar and select Align | On Grid from the context menu.

Zooming in and out
The zoom of a design can be adjusted individually for each Design window. SchemaAgent provides the Layouts
| Zoom menu command as well as the Zoom toolbar to this aim. In addition, you can zoom in and out of a
design view by scrolling (with the scroll-wheel of the mouse) while keeping the Ctrl key pressed.
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To zoom in or out of a design view:

1. Do one of the following:

· Select the menu command Layout | Zoom and then select Zoom.

· Click the Show Zoom dialog  toolbar button.

The Zoom dialog box appears.

2. Do one of the following:

· Adjust the zoom factor using the slider.
· Enter a specific zoom factor in the box below the slider.

3. Click OK.

Alternatively, you can also select a zoom factor from, or enter it in, the drop-down list in the Zoom toolbar.

To make all file boxes fit in a Design window:

· Do one of the following:

· Select the menu command Layout | Zoom and choose Zoom to fit from the sub-menu.

· Click the Zoom to Fit  toolbar button.

The zoom factor is adjusted so that all file boxes in the Design window become visible.
 

To zoom to a selection:

1. Select one or more file boxes.
2. Do one of the following:

· Select the menu command Layout | Zoom and then select Zoom to selection.

· Click the Zoom to Selection  toolbar button.

The zoom factor is adjusted so that the selected file boxes in the Design window become visible.
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4.6.1 Creating and Saving Designs

A Design window is where you can view and graphically design and manage the relationships , that is IIRs
(Includes, Imports, or Redefines), between an unlimited number of W3C XML schemas, and also display the
relationships between XSLT stylesheets, Web Services Description (WSDL) files, MapForce Design (.mfd) files
or XML files and their associated schemas. In this way, you can organize schemas (and .mfd or XML files) into
collections of related files.

A SchemaAgent design can be saved as an .sad file for editing at a later time. Note that a set of files (and,
therefore, their relationships) can be contained in multiple SchemaAgent designs. Any IIR relationship created
in a SchemaAgent design is immediately propagated to the respective files as soon as the relationship is
created.

To open a new SchemaAgent design window:

· Select the menu command File | New (Ctrl+N) or click the New  toolbar button.

To open an existing SchemaAgent design (file):

1. Select the menu command File | Open (Ctrl+O) or click the Open  toolbar button. The Open
dialog box appears.

2. Select the desired file and click Open.

To open a recently used design file:

· On the File menu, click one of the recently opened files.

To save a design:

1. Select the menu command File | Save (Ctrl+S) or click the Save  button in the Standard toolbar.
Alternatively, select the menu command File | Save As... if you want to save the file under a different
file name or path.

2. If the design has not been saved before, choose a path and enter a file name in the Save As dialog
box.

To close the currently active design file:

1. Select the SchemaAgent design window for the design file you want to close.
2. Select the menu command File | Close.
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4.6.2 Inserting Files and Folders

Files with supported extensions are added to a design either using the context menu in the Explorer window or
by dragging them from the Explorer window into a Design window. Each file is displayed as a file box. Existing
relationships between files are represented with colored lines.

To insert files or folders into a design:

In the Explorer window, do one of the following:

· To insert one or several individual files, select the desired files and drag them into a Design window
using the left mouse button.

· To insert all files contained in a folder, drag the folder into a Design window.

The files or the files contained in the dragged folders, respectively, appear in the Design window. Alternatively,
you can also select one or several files or folders and choose Insert into current design from the context
menu or press Insert.

To insert the file(s) as well as all directly or indirectly referenced files:

· Select one or more files, drag them into a Design window using the right mouse button and select the
desired option from the context menu that appears. The selected file(s) as well as the respective
referenced files appear in the Design window.

4.6.3 Inserting Related Files

Once you have added a schema, a mapping design file, or an XML file to a Design window, you can add all the
related files to the design.

To insert related underlying files into the design:

· Right-click the title bar of a file box and select one of the following options from the Insert menu:

· All directly referenced
· All directly referencing
· All directly related
· All referenced
· All referencing
· All related
· All linked

Each of these menu options opens a sub-menu, from where you can choose Files, Schema files, XML files,
XSLT files, WSDL files, or MapForce designs. The Files option will insert all files that meet the
requirements; the remaining options will restrict the inserted files to the chosen file type.

Note that the options above are also available when you insert a file into a Design window by dragging it from
the Explorer window using the right mouse button.
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4.6.3.1  Directly Related Files

Files that are directly related are displayed with an uninterrupted connector line between them in a Design
window.

Directly referenced files
These are files that are directly referenced with an include, import, or redefine (IIR) statement. For example, if
Schema A has an Include statement that references Schema B, then Schema B is directly referenced by
Schema A.

An XML file can reference one or several XML schemas or XSLT stylesheets.

An XSLT file can import XML schemas, and import or include other XSLT files. Moreover, it can also have one or
more inline schemas defined. All these relations are direct references.

Other imported WSDL files and XML schemas as well as any inline schemas that may exist are directly
referenced by WSDL files.

An .mfd file directly references its source and target schemas as well as XML instances.
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Directly referencing files
In this case, the file to be inserted references the selected file with an IIR statement, that is, the selected file is
referenced by the file to be inserted. In our example above, Schema A is directly referencing Schema B and
Target.xsd is directly referencing Design File.mfd.

All directly related
This option applies to both directly referenced and directly referencing files.

4.6.3.2  Indirectly Related Files

When files are indirectly related to each other, no direct connection is visible between the file boxes. The
relation is established via a third file box with a direct relation to these files.

Referenced files
These are files that are directly as well as indirectly referenced. For example, if Schema A has an Include
statement that references Schema B, and Schema B has an Include statement that references Schema C,
then (i) Schema B is directly referenced by Schema A, (ii) Schema C is directly referenced by Schema B, and
(iii) Schema C is indirectly referenced by Schema A (since Schema A references Schema B, which in turn
references Schema C).

If a schema that is directly referenced by an XML file references another schema (e.g. Schema B is imported
by Schema A), this schema (Schema B in our example) is said to be indirectly referenced by the XML file.

Any schemas and XSLT files that are included or imported in files directly referenced by XSLT stylesheets are
said to be indirectly referenced by these stylesheets. So, in the example below, Catalog.xsd is indirectly
referenced by Stylesheet.xslt because it is imported in Import.xslt which is included in Stylesheet.xslt.
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WSDL files can contain (inline) schemas or and these (inline) schemas can include, import, or redefine other
schemas. Any schema that is included, imported, or redefined in such a schema (like Schemas Import, D, and
Catalog in the example below), is indirectly referenced by the WSDL file.

In the case of an .mfd file, in addition to the directly referenced source and target schemas, any schema that
the source schema references or the target schema is referenced by (Schema Z in our example) is considered
to be referenced by the .mfd file.

Referencing files
Files that are directly as well as indirectly referencing the selected file.

All related
This option applies to both referenced and referencing files with a direct as well as indirect reference.

4.6.3.3  Linked Files

These are schemas that are directly and indirectly referenced, as well as schemas that are linked to any of the
directly or indirectly referenced schemas in any way. For example, if we extend our previous example so that
Schema Z includes Schema B, then Schema Z is linked to Schema A (because Schema A includes
Schema B). Further, if Schema Z, which is linked to Schema A, is either the target or source schema of an
.mfd file, then that .mfd file is considered to be linked to Schema A. 

The file Web Service.wsdl is also linked to Schema A because it uses Schema Z which includes Schema
B and Schema A includes Schema B. 
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The file Stylesheet.xslt is linked to Schema A because it is referenced by instance.xml, which in turn
references Schema A.

4.6.4 Arranging Files in Designs

After you have inserted files into a Design window, you can arrange the file boxes on the design pane by
dragging them to the desired location with the mouse. For designs containing a large number of files, the
Overview window  provides an overview so that you can see at a glance where in the design the visible part is
located.

You can resize boxes by dragging box borders as well as expand or collapse them by clicking the expand 
button in the title bar of boxes.

Within a Design window, you can navigate from one file box to the next using the cursor keys (Up, Down, Left,
Right).

To expand or collapse a file box:

· Click the expand  button in the title bar or a file box.

To expand or collapse the tree structure in a file box:

Do one of the following:

· To expand or collapse individual items, click the plus or minus icons to the left of the item.
· To expand or collapse an individual item and its children, right-click the item and select Expand all

children or Collapse all children from the context menu.
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· To expand or collapse all items in a file box, right-click any item in the box and select Expand all or
Collapse all from the context menu.

To show all expanded items in a file box:

· Right-click anywhere in an expanded section of the file box and select Size to fit from the context
menu.

4.6.5 Viewing Schemas

In the Design window, each schema is displayed as a box which can be expanded and collapsed. When
schemas are inserted into a design, they appear as collapsed schema boxes.

In the above schema, note that—apart from the arrowhead in the expand  button—there are two more
arrowheads. The arrowhead on the left indicates that this schema either includes, imports, or redefines other
schemas or schema components. By expanding the schema box, you can determine exactly which other
schemas or schema components are included, imported, or redefined. The arrowhead on the right is used to
create an IIR  that includes, imports, or redefines this schema or its schema components in other schemas.

Minimized schema boxes can be expanded by clicking the button in the title bar. They expand into four
sections: Includes, Imports, Redefines, and Globals. In the screenshot below, the arrowheads at the left of the
Imports and Redefines sections indicate that this schema imports at least one schema and redefines at least
one schema component from an external schema.
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Each section of the schema box can be further expanded if a sub-structure is present (indicated by the expand
 button in the upper-right corner of the schema box), and this sub-structure is displayed as a freely

expandable tree structure of IIRs and global components.

The arrowheads move depending on the level of detail that you display by expanding the individual sections.
Note the double arrowhead next to the OfficeType complex type indicating that two relationships are contained
in this section.
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To view a schema:

1. Drag and drop the schema you want to view from the Explorer window onto a Design window or use the
context menu to add the file to the current design.

2. Optionally, expand the sub-sections to view detailed information on IIRs or components.

4.6.6 Viewing XML instance files

XML files that are inserted into a design are displayed as collapsed XML boxes.

The design of an XML box is basically identical to the design of a schema box . The box can be expanded
and then shows three sub-sections. In the screenshot below, the arrowhead at the left of the Schema section
indicates that this XML instance has an XML schema defined.

You can further expand the Schema and the Root sections of the XML box to see which XML schema and
which namespaces are defined for the XML file.

If the XML instance has also an XSLT stylesheet defined, you can expand the stylesheets section and view
information on the XSLT file.
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To view an XML file:

1. Drag-and-drop the XML file you want to view from the Explorer window onto a Design window or use the
context menu to add the file to the current design.

2. Optionally, expand the sub-sections to view detailed information about schemas, stylesheets, or
namespaces.

4.6.7 Viewing XSL/XSLT stylesheets

An XSLT stylesheet appears as a collapsed XSLT box when it is inserted into a Design window.

The expanded box shows five sub-sections for imported or included XSLT files, imported schemas, inline
schemas, and stylesheets.

Expanding the sub-sections displays the names of the imported or included files, and the namespaces that are
defined for the stylesheet.
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Note: Since stylesheet files of version 1.0 support neither importing schemas nor inline schema, the relevant
sections are not displayed in the file boxes of these files. The version of a stylesheet file is displayed in the
Quick Information  of a file box.

To view an XSLT file:

1. Drag-and-drop the XSLT file you want to view from the Explorer window onto a Design window or use
the context menu to add the file to the current design.

2. Optionally, expand the sub-sections to view detailed information about imports or includes, imported or
inline schemas, or namespaces.

4.6.8 Viewing WSDL files

When you add a WSDL file to a Design window, it appears as collapsed.

The expanded box shows four sub-sections for imported WSDL or XML schema files, inline schemas, and
definitions.
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When you further expand the sub-sections, you can view details about the imported WSDL files or XML
schema, the inline schemas, and the individual definitions of the web service.

SchemaAgent also supports WSDL 2.0.
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To view a WSDL file:

1. Drag and drop the WSDL file from the Explorer window onto a Design window or use the context menu
to add the file to the current design.

2. Optionally, expand the sub-sections to view detailed information about imported WSDL or schema
files, inline schemas, or web service definitions (WSDL 1.1) or web service descriptions (WSDL 2.0),
respectively.

4.6.9 Displaying Relations

SchemaAgent can illustrate a number of different relations between the files it supports.
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· IIR relations between XML schemas  (includes, imports, and redefines)
· Relations between XML instances  and XML schemas or XSLT stylesheets
· Include and import relations between XSLT stylesheets  as well as relations between XSLT

stylesheets and XML schemas
· Import relations between WSDL files  as well as relations between WSDL files and XML schemas
· Relations between MapForce Design (.mfd) files  and XML schemas, XML instances, or WSDL files

These relations are illustrated by solid lines between the individual file boxes by default. The lines have different
colors indicating the kind of relations that exists between particular files. You can customize the appearance of
the connector lines in the Colors  and Relations  tabs of the Options dialog (menu command Tools |
Options).

Component relations
Lines that show relationships between global components in two schemas are dashed by default. For such
relations to be visible, the Globals sections of both schemas must be expanded.
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Likewise, relations between an .mfd file and global components in its source and target schemas are indicated
by dashed lines. Again, for such relations to be visible, the Globals sections of the schema as well as the .mfd
file's Input or Output section, respectively, must be expanded.

Highlighting connector lines
When you place the cursor over a connector line, the line becomes highlighted and a tooltip appears with
details about the relationship. The arrowhead on the line indicates the "direction" of the relationship.
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In the screenshot above, the blue import relation is highlighted and it shows that address.xsd is imported in
NanonullOrg.xsd. The appearance of highlighted connector lines can be configured from Tools | Options |
Relations.

Selecting connector lines
Click a line to select it. Right-click a line to reveal context menu options.

In the screenshot above, the green include relation is selected. The appearance of a selected line can be
configured from Tools | Options | Relations. Note that a selected line can also be highlighted.

4.6.9.1  Schema Relationships

Lines that show relationships between schemas are solid by default. Different colors are used to distinguish
Imports, Includes, and Redefines; the default settings show Imports in light blue, Includes in green, Redefines
in purple-violet.
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Note that the connector points directly to the referenced component if you also expand the section within the
schema box.

4.6.9.2  XML Instances

Relationships that exist between XML schemas or XSLT stylesheets and their corresponding XML instances
are also displayed in SchemaAgent.

The default color for schema relations is red. The default color for stylesheet relations is cyan.

4.6.9.3  Stylesheet Relationships

XSLT stylesheet files can import or include other XSLT files or XML schemas. In addition, one or several inline
schemas may be present in an XSLT file. SchemaAgent illustrates these relationships with different colors.
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The default color for imports is dark green, for includes it is light green, and for schema relations it is light blue.

Changing the order of imported or included XSLT files
The sequence in which the imported or included stylesheets are applied is important in XSL transformations.
For this reason, these files are not sorted alphabetically by default, but in the order of their insertion. You can,
however, change the sorting order if necessary.

To change the order of imported or included XSLT files:

1. Expand the "imports" or "includes" section to view the related XSLT files.
2. Right-click the file whose position you want to change and select either Move up or Move down from

the context menu, as applicable:
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3. Optionally, repeat step 2 until the file shows up at the desired position.

Inline schemas
If the XSLT file contains inline schemas, you can show a file box for the inline schema. The file box for the inline
schema has a dashed border; apart from that, you can proceed as with any other XML schema box.

To display an inline schema:

1. Expand an XSLT box until the inline schemas are listed under the "inline schemas" section.

2. Do one of the following:

o Right-click an inline schema and select the Show inline option from the context menu. 

o Click the  icon to the left of the inline schema entry.

o Double-click the inline schema entry. 
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To hide an inline schema:

· Do one of the following:

o Right-click an inline schema and clear the Show inline option from the context menu.

o Click the  icon to the left of the inline schema entry.

o Double-click the inline schema entry.

4.6.9.4  WSDL Relationships

WSDL files can import other WSDL files or XML schemas. In addition, one or several inline schemas may be
present in a WSDL file. SchemaAgent illustrates these relationships with different colors.

The default color for imports is magenta; for schema relations, it is light blue.

Inline schemas are displayed when you expand the "types" section in a WSDL box. You can also show a file
box for the inline schema. The file box for the inline schema has a dashed border; apart from that, you can
proceed as with any other XML schema box.

To display an inline schema:

1. Expand a WSDL box until the inline schemas are listed under "types".
2. Do one of the following:

o Right-click an inline schema and select the Show inline option from the context menu.

o Click the  icon to the left of the inline schema entry.

o Double-click the inline schema entry.

To hide an inline schema:

· Do one of the following:
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o Right-click an inline schema and clear the Show inline option from the context menu.

o Click the  icon to the left of the inline schema entry.

o Double-click the inline schema entry.

4.6.9.5  MapForce Design Relationships

When a MapForce design file is concerned, solid connector lines lead from the .mfd file to the respective
source and target schemas or any existing XML instances. By default, the color of relations between .mfd files
and schemas is blue. The default color of relations between .mfd files and XML instances is green.

The default color of relations between .mfd files and WSDL files is magenta.

4.6.10 Showing Related Components

A schema component or its type may be defined in another schema (which is indicated by arrowheads on the
left-hand side of the component) or used by another schema (indicated by arrowheads on the right-hand side of
the component). For example, the complex type ipo:US-Address illustrated below in blue color (according to
the default color scheme) denotes an import.
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You can view the origin or usage for such components as follows:

1. Right-click a component and select Show component origin (or Show component usage, if
applicable) from the context menu.

2. Optionally, click Yes in the message box that pops up if the schema of the source component is not
present in the current design.

The instructions above are applicable for both XML schemas and .mfd files added to the Design window.

The Show component origin command adds the relevant definition in the source schema (in this example,
address2.xsd) to the design.
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Conversely, the Show component usage command adds to the design the relevant definition of the schema
where the type is used. In the design illustrated below, the type ipo:Address defined in address2.xsd is used
in ipo2.xsd.
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4.6.11 Viewing MapForce Design Files

When MapForce (https://www.altova.com/mapforce) and MapForce Integration Package are installed on the
same computer, you can view detailed information about mapping design files (.mfd) in SchemaAgent Client,
specifically:

· The source or target components that are XML based
· The XML instance files that were designated as input or output in MapForce (if any). 
· Any source or target components that are calls to WSDL-style Web services
· Relations between all of the above and other files

Notes:

· While MapForce requires a license, the MapForce Integration Package is a free component available
for download at https://www.altova.com/mapforce/download.

· If the .mfd file contains XML schema components, XML inputs or outputs, or calls to WSDL-style web
services, the information shown has the same level of detail as if you examined a standalone XSD,
XML, or WSDL component in SchemaAgent Client. If the .mfd file contains components not supported
by SchemaAgent (like CSV or Excel files or databases), such inputs and outputs are not displayed.

To view information about an .mfd file in SchemaAgent, do one of the following:

· Drag and drop the .mfd file from the Explorer window onto a Design window.

https://www.altova.com/mapforce
https://www.altova.com/mapforce/download
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· Right-click the .mfd file in the Explorer window, and select Insert into current design from the context
menu.

The source and target components are listed when you click the expand  button. Source components are
shown on the left side; target components—on the right. To quickly view the full structure of the .mfd file, right-
click the title bar, and select Expand All from the context menu.

To view the mapping design as it appears in MapForce, click the Design  button located between the input
and output files.
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The Mapping tab shows the design view. The XSLT tab displays the MapForce-generated XSLT output. This
tab appears only if the transformation language of the mapping is XSLT. The Output tab displays the execution
result of the mapping.

To close the design pane, click the Design  button again.

Note: In order for the Design pane to be displayed, MapForce and MapForce Integration Package must be
installed on your computer. You cannot edit an .mfd file directly in SchemaAgent., except for setting the input
or output instances, as further shown below.

To open any .mfd file for editing in MapForce, use any of the following shortcut commands:

· Right-click an .mfd file in the Explorer window and select Edit in MapForce from the context menu. 
· Right-click the title bar of an .mfd file in the Design window and select Edit in MapForce from the

context menu.
· Select the file in Explorer window and press Ctrl+M.

Setting input or output
In SchemaAgent Client, you cannot directly edit .mfd files; however, you can set the input or output XML
instances of XML based components. 

A MapForce design file may contain one or several source XML components, and one or several target XML
components. In SchemaAgent Client, the source components appear to the left of the box, while target
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components appear to the right. For example, the .mfd illustrated below has one source and one target
component:

If the source component is an XML schema like in the image above, it typically has an "input" instance file—
this is the XML file from where the mapping will read data when you execute it in MapForce. The target
component, on the other hand, typically has an "output" instance file—this is the XML file to which data will be
written. For example, the .mfd illustrated below reads data from books.xml and writes data to library.xml.

Notice the prefix "Input" before the input instance file, and the prefix "Output" before the output file. 

To set the input or output file of a component:

1. Drag the required XML file from the Explorer window into the Design window. 
2. Click the input or output connector (small triangle) to the left or right of the XML file box and, holding

the mouse key pressed, drag it onto a source or target .xsd component. A new instance file is added
and it gets either the "Input" or "Output" prefix.

Note: A MapForce component has one input and one output file at most. An error message appears if you
attempt to add more.

3. If it is required to convert the input file to output, or vice versa, right-click the file and select Toggle
instances from the context menu, see below.

To delete an existing input or output instance:

· Right-click the instance file and select Delete from the context menu. Alternatively, select the file and
press Delete.
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Toggling input and output instances
You can change an "Input" instance file to become the "Output" instance file, and vice versa, directly from
SchemaAgent Client. Consider this operation as equivalent to switching the Input XML File and Output XML
File on the mapping component settings in MapForce:

Component Settings in MapForce

To designate the input instance file as output, or vice versa:

· Right-click the parent XML schema, the Instances node, or either of the XML instances and choose
Toggle instances from the context menu.

After you run the Toggle Instances command, the "Input" instance file of the respective schema component
becomes "Output", and the "Output" becomes "Input", respectively. Note that the MapForce component
settings are also updated with immediate effect.

4.6.12 Displaying Quick Information

When you move the mouse pointer over the title bar of a file or a connector line in a Design window,
SchemaAgent displays a Quick Info box with details such as file location, target namespace, IIR information,
and so on. The type and amount of information displayed in a Quick Info box depends on the object being under
the focus of the mouse pointer.
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A Quick Info box is provided for the following objects:

· Schema boxes
· Schemas contained in the individual sections of other schema boxes
· MapForce design file boxes
· Schemas contained in the Input or Output section of .mfd file boxes
· XML instances
· IIR connector lines
· MapForce connector lines
· Component relation connectors
· References to XML instances

Note: The Quick Info box displays IIR information as determined in the search path.

Placing the text cursor over an alert  icon, if visible in the file box, opens the relevant error message in the
Quick Info box.

Schemas
When you move the mouse pointer over the title bar of a schema box, a Quick Info box containing the following
information is displayed:

· Location of the schema
· Target namespace and prefix
· IIR information about the schema, for example, what schemas are included in that schema, and in

which schemas that schema is included itself.

When you have expanded a schema box and move the mouse pointer over the file name of an included,
imported, or redefined external schema, the Quick Info box displays the following information about the external
schema:
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· Location of the schema
· Target namespace and prefix

MapForce design files
When you move the mouse pointer over the title bar of an .mfd box, a Quick Info box containing the following
information is displayed:

· Location of the file
· Source file(s)
· Target file(s)

When you move the mouse pointer over the file name of a schema contained in the .mfd file, the Quick Info box
displays the following information:

· Location of the schema

XML instances
When you move the mouse pointer over the title bar of an XML instance file box, a Quick Info box containing
the following information is displayed:

· Location of the XML file
· Referenced file(s)
· Files writing the XML instance, if applicable
· Files reading the XML instance, if applicable

XSLT stylesheets
When you move the mouse pointer over the title bar of an XSLT stylesheet box, a Quick Info box containing the
following information is displayed:

· Location of the XSLT file
· XSL version
· Imported XSLT files
· Included XSLT files
· Imported XML schemas
· Files containing the XSLT file
· Inline schemas contained in the XSLT file

Web Service Description files
When you move the mouse pointer over the title bar of a WSDL file box, a Quick Info box containing the
following information is displayed:

· Location of the WSDL file
· WSDL version
· Target namespace
· Imported WSDL files
· Imported XML schemas
· Files containing the WSDL file
· Files reading the WSDL file
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· Inline schemas contained in the WSDL file

Relations
When connector lines between schemas, .mfd files, XML instances, or components and their respective source
or target item are highlighted, a Quick Info box is displayed. The content of the Quick Info box differs depending
on the type of the highlighted connector.

The following is displayed for relations:

· Type (Import, Include, Redefine, MapForce, or Reference)
· Source
· Target

When you move the mouse pointer over a component relation, the Quick Info box contains information
regarding the input component the MapForce item reads from, or the MapForce item the output component is
written by, respectively.
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4.7 Working with Designs

When working with SchemaAgent designs in a Design window, you can not only select  file boxes,
rearrange or remove  them, but also reload files  that have been changed outside SchemaAgent Client as
well as print  and export  designs. Context menus are available for the design  itself as well as for file
boxes and connector lines . You can correct incorrect reference paths  and even recreate ghost files .

4.7.1 Selecting Files

When selecting a single file in a Design window, the file box changes its color and the selected box
automatically receives the focus, which is indicated by the title also being displayed in a different color. You
can change the color for selected files in the Options . The selection mechanism is explained below with
reference to schemas; note that the same mechanism applies to other supported file types.

Selecting multiple files
In a Design window, several files can be selected at a time. The title bars of the selected files change their
color. The way in which you select the files determines which file will get the focus:

· If you use the Ctrl+click method to select multiple file boxes, the last file box that is selected will
receive the focus.

· If you use the marquee selection method, the last file box over which the cursor passes will receive the
focus.

· If you drag the marquee in such a way that the cursor passes over no file box, then no file will receive
the focus.

To select multiple schemas in a Design window:

Do one of the following:

109

111 115

125 126 115

123 112 114

150



110 SchemaAgent Client Working with Designs

© 2019-2025 Altova GmbHAltova SchemaAgent 2025

· Click the schema boxes of the schemas you wish to select while keeping the Ctrl key pressed.
· Use the marquee selection technique on the schema boxes of the schemas you wish to select (that is,

click and drag the marquee rectangle around the required schema boxes).

Changing the focus
For some actions, such as aligning, it is important to set the focus correctly because the selected files are
aligned on the file that has the focus. For other actions, such as sorting, the focus is irrelevant.

To change the focus in a multiple selection:

· Press Ctrl and click twice on the box of the file to which you want to give the focus.

Selecting related files
Schema boxes are selected automatically when you run the Show Component Origin , Show Component
Usage , and Show Relation Path  commands.

Another way to select related files in a design is to right-click a file and choose one of the following options
from the Select sub-menu of the context menu. Each of the options provides a sub-menu where you can further
restrict your choice to certain file types, or choose Files to select all files.

· All directly referenced: Selects all files that are directly referenced by the selected file.
· All directly referencing: Selects all files that are directly referencing the selected file.
· All directly related: Selects all files that are either directly referenced by, or are directly referencing

the selected file.
· All referenced: Selects all files that are directly as well as indirectly referenced by the selected file.
· All referencing: Selects all files that are directly as well as indirectly referencing the selected file.
· All related: Selects all files that are either referenced by, or are referencing the selected file directly

as well as indirectly.
· All linked: Selects all files that are directly and indirectly referenced, as well as files that are linked to

any of the directly or indirectly referenced files in any way.

Alternatively, you may also select a file in the Design window and choose the menu option Edit | Select. Use
one of the options in the appropriate sub-menu to select the desired files in the Design window.

In addition to the menu, you can always use the keyboard shortcut Ctrl+A to select all files in the active
Design window.

Copying and pasting a selection
Selections can be copied and pasted across designs. When used with paths, this is a convenient way to
create new designs containing closely related schemas.

Synchronizing Selections
The context menu of a selected file box provides an option to synchronize the selection in the Design window
and the Explorer window. This command is useful when a Design window is active. Namely, if you choose the
Synchronize Selection command in the Design window, then the currently selected file in the Design window
is also selected in the Hierarchical and Flat tabs of the Explorer window, enabling you to switch to the Explorer
pane and take the required action.
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Note: Synchronized selection only applies to the currently selected Design window and not to all open Design
windows.

To synchronize a selection:

Do one of the following:

· Double-click a file in the Hierarchical tab or the Flat tab of the Explorer window, or in a Design window.
The file is then selected in the other two tabs as well.

· Choose the menu option Edit | Synchronize Selection.
· In a Design window, right-click a file box and choose Synchronize Selection from the context menu.

· Click the Synchronize Selection  button in the standard toolbar.

4.7.2 Removing Files from a Design

In contrast to deleting a file in the Explorer  window, a file that is removed from a design will remain available
in the file system of your computer as well as in other designs where it is contained.

Note: Be sure that the focus of the selected file is on the Design window and not in the Explorer window if you
just want to remove the file from the design. Otherwise you will delete the file from your file system and it will
not be removed from the design but will appear as a so-called unknown file since the relevant SchemaAgent
server is not able to locate a file of the given name in any of its search paths. Such a file is represented in
Design windows with a yellow exclamation mark.

The only way to bring a deleted file back into use (thus making the yellow exclamation mark disappear) is to
have the file physically re-created or copied from a backup to its correct location.

To remove a file from a design:

Do one of the following:

· Right-click a file in a Design window and select Delete from the context menu.
· Select a file in a Design window and choose the menu option Edit | Delete or press the Delete key.

· Click the Delete  button in the Standard toolbar.

4.7.3 Ghost Schemas and Incorrect Paths

If a file contains a reference to another file that cannot be found at the specified location—a so-called ghost file

—, an error  icon appears in the top left of its title bar. The ghost file is indicated by the ghost  icon in its
title bar. In the screenshot below, ipo.xsd has an Include statement that points to the schema address.xsd,
which cannot be located at the location specified in the Include statement. In this case, address.xsd is the
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ghost schema file. Consequently, any file that references address.xsd is marked with the error  icon, both in
the Design window and in the Explorer window.

An XML instance is also marked and treated as ghost file if it cannot be found, for example:

A schema can be a ghost schema for any of several reasons. The most common are:

· The schema is not physically present at the specified location for any of several reasons. For example,
it might have been moved.

· The schema cannot be loaded because the web server or network node is unavailable.

Note that ghost files are displayed in the Explorer and Design windows (even though they are not at the
location specified in the reference). In the design, the connector line between the ghost file and its target
schema is also displayed.

If you encounter incorrect references and ghost files, there are two possible ways to deal with the problem:

· Correcting the path to the reference
· Recreating the ghost file

4.7.3.1  Correcting Reference Paths

When you right-click a file with an incorrect reference, the Correct reference paths command is available in
the context menu. This command instructs SchemaAgent Client to look for files of the same name in all the
search paths. This is the ideal solution if the ghost file has been moved to another location within the search
path. 
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To correct a single reference path:

· In the Explorer window or in a Design window, right-click a file with an error  icon and select Correct
reference paths from the context menu, or select the file and press Ctrl+R, or click the Correct

reference paths  button in the Extras toolbar.

If one or more matches are found, all the available alternative paths are listed in a dialog box. You can expand
the entries to check if the structure of the found file is really identical with the missing file. The dialog box is
resizable so that you can display even very long paths or show complex schemas in detail without having to
use the scroll bars.

Correcting multiple paths
You can also attempt to correct all incorrect paths in one single step. This will correct all paths in
SchemaAgent independent of the files displayed in a Design window. You can also perform this operation with
no Design window open.

To correct all reference paths:

1. Select the menu command Extras | Correct all reference paths.
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2. Optionally, select the Don't prompt if only one match found check box if you want paths corrected
automatically when only one alternative path is found.

3. Click Start. The "Correct reference path" dialog box appears for the first ghost file. Be aware that a
separate "Correct reference path" dialog box will be displayed for each of the ghost files found in the
design. If no match is found for a particular ghost file, this is reported in a message box, for example:

4. If at least one match is found, do one of the following:

· Select a matching path and click Yes to confirm the correction. Note that a single match will be
confirmed automatically without showing a dialog box if you've selected the Don't prompt if only
one match found check box.

· Click Yes to All to confirm all single matches without prompting.
· Click Skip to jump to the next ghost file without correcting the current path.
· Click Abort to terminate the process without correcting the remaining paths.

4.7.3.2  Recreating Ghost Files and XML Instances

From within SchemaAgent Client, you can recreate the ghost schema as a rudimentary schema at the location
specified in the reference. A rudimentary schema is one that contains only the xs:schema declaration. A ghost
XML instance is recreated as a rudimentary XML file containing only an empty <root /> element. However,
you still have to add appropriate content to the recreated rudimentary file.

Note that if the folder specified at the location defined in the reference statement does not exist or is not within
the search path, then the Recreate command is not available. This ensures that the reference path correctly
points to the specified schema or XML file, respectively. 
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To recreate a schema:

1. In the Explorer window or in a Design window, select a ghost schema and do one of the following:

· Select the menu command Edit | Recreate.
· Right-click and select Recreate from the context menu.

A rudimentary schema of the same name is created at the location specified for it in the IIR statement.

2. Open the rudimentary schema in XMLSpy and add appropriate content.

To recreate an XML file:

1. In the Explorer window, right-click a ghost XML file and select Recreate from the context menu. A
rudimentary XML file of the same name is created at the location specified for it in the reference.

2. Open the rudimentary XML file in XMLSpy and add appropriate content.

4.7.4 Reloading Files

If a file is edited in an external editor program (for example, XMLSpy or MapForce) , the changes are not
automatically reflected in SchemaAgent Client. In order to view the structure of the modified file in
SchemaAgent Client, you have to reload the respective file.

To reload a file:

· Right-click the required folder or file in the Explorer window or in a Design window and select Reload
from the context menu.

4.7.5 Design Options

When you right-click anywhere in the Design window, the context menu provides a series of commands that
facilitate the editing and changing the layout of a SchemaAgent design. The content of the menu changes
dynamically depending on where you right-click in the Design window:

· Design window background
· File box or section caption (the content also changes depending on the file type)
· Blank area in a section
· Item in a section (the content also changes depending on the item type)
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Design window background

· Select Files: Opens a sub-menu for selecting file boxes by type.

· Paste (Ctrl+V): Pastes a file box that you have previously copied into the clipboard from the Explorer.
· Show Grid (Alt+G): Toggles the display of the grid on and off.
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File box or section caption

· Cut (Shift+Delete): Copies the selected file(s) to the clipboard and deletes it from the design.
· Copy (Ctrl+C): Copies the selected file(s) to the clipboard. You can use this command to copy files

from one design window to another.
· Paste (Ctrl+V): Pastes the content of the clipboard to the active design window.
· Delete: Removes the selected file(s)  from the design. Please note that the files will not be deleted

from the file system.
· Expand all: Expands all sub-sections (includes, imports, redefines, globals,  Inputs/Outputs,

schemas, stylesheets, root, import schemas, inline schemas, stylesheets, types, definitions) of the
selected file box.

· Collapse all: Collapses all expanded sub-sections of the selected file box.
· Size to fit: Resizes the file box so that all expanded content is visible.
· Reload: Updates the display  of the selected files. If more than one file is selected, the command

reads Reload files.
· Recreate: Creates a rudimentary XML schema  with the name of, and at the location specified in an

IIR statement for, the selected ghost schema(s). This option is only available for ghost files . If more
than one file is selected, the command reads Recreate files.

· Synchronize Selection: Synchronizes the selection  of the Explorer and the Design windows, so
that the file selected in the Design window is also selected in the Explorer.
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· Select: Opens a sub-menu providing several selection  options.

· Insert: Opens a sub-menu (identical to the Select sub-menu illustrated above) providing several
options for inserting related files .

· Align: Opens a sub-menu providing several options for aligning the selected files  and toggles the
grid display on and off.

· Sort: Opens a sub-menu where you can sort the selected files  by name or by width, either
ascending or descending.

· Correct reference paths (Ctrl+R): Tries to find an identical file  at a different location within the
defined search paths. This option is only available for files with an IIR statement defined pointing to a
file that cannot be found at the specified location.

· Edit in XMLSpy: Opens the selected files for editing in XMLSpy. This option is not available for .mfd
files. If more than one file is selected, the command reads Edit files in XMLSpy.

· Edit files in MapForce: Opens the selected files for editing in MapForce. This option is only available
for .mfd files. If more than one file is selected, the command reads Edit files in MapForce.

· Edit target namespace: Allows you to add an additional namespace to the namespace definition in
the Globals section of the selected schema. SchemaAgent expands the Globals section of the
schema box and adds a new ns element where you can enter the definition of the target namespace. If
a target namespace is already existing, it is selected for editing.

Note: In WSDL files that contain inline schemas, the target namespaces also applies to the inline schemas.
You may have to consider this if you plan to edit or delete the target namespace in a WSDL file.

· Remove target namespace: Deletes the target namespace from the selected schema.
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· Create inline schema: Creates an inline schema for the selected XSLT or WSDL file. This option is
not available for schemas, .mfd files, and XML instances.

Blank area in a section
If you right-click into a blank area of an expanded section, the context menu provides the Size to fit, Expand
all, and Collapse all commands. The definitions section of a WSDL file box additionally offers the Edit target
namespace and Remove target namespace commands. Please note that these commands apply only to
the particular section where the cursor is positioned when calling the command.

Items in a section

· Size to fit:  Resizes the section so that all expanded items are visible.
· Expand all children: Expands any available children of the selected item.
· Collapse all children: Collapses any available expanded children of the selected item.
· Show inline: In XSLT and WSDL file boxes, shows the inline schema as a separate schema box.
· Delete (Delete): Deletes the IIR relation between the item and the parent file (i.e., the file that is

represented by the file box in which the item is displayed).
· Insert into current design (Insert): Inserts the corresponding file box of the item into the current

design. This option is grayed out if the file box is already present in the design.
· Toggle instances: In .mfd file boxes, toggles between input and output XML instances. You can use

this option independently for the input and output schemas of the .mfd file. This option is only available
for .mfd files.

· Show component origin: Selects and expands the file box where the component originates from or
inserts that file box into the design, if desired.

· Show component usage: Selects and expands the file box where the component  is used or inserts
that file box into the design, if desired.

Drag-and-drop
In addition to the options available in the context menu, you can also use drag-and-drop to move a file within a
design window or to copy a file to another design window.

To move a file within a Design window:

· Drag the file to the desired position.
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To copy a file to another Design window:

· Drag the file from the first Design window to the desired Design window and drop it. If the target window
is not visible, move the mouse pointer to the corresponding tab at the bottom of the Design window to
activate the target window and drop the file there.

4.7.5.1  Aligning Files in Designs

SchemaAgent provides several options for automatically aligning the file boxes in a Design window. You can
select these options either via the Layout menu, by selecting and right-clicking several file boxes in a Design
window, or by clicking the appropriate toolbar icon in the Alignment toolbar.

Aligning box edges
When several file boxes are selected in a Design window, you can choose from among several aligning options
provided in the sub-menu that opens when you select the menu option Layout | Align Edges or when you
right-click the Design pane and select Align | Edges from the context menu.

The selected file boxes will be aligned with the file box that has the focus. You can change the focus within a
selection by double-clicking a file box while holding down the Ctrl key. If you add a file to a selection, the focus
will be automatically set to the newly added file.

To align the edges of file boxes:

1. Select the file boxes you want to align, giving the focus to the file box you want to align the others with.
2. Select the menu command Layout | Align Edges or right-click and select Align | Edges from the

context menu. A sub-menu appears.
3. Select from this sub-menu, how you want the edges aligned. Alternatively, skip step 2 and do one of

the following:

· Press Ctrl+Left or click the Align Left Edges  button from the Alignment toolbar.

· Press Ctrl+Right or click the Align Right Edges  button from the Alignment toolbar.

· Press Ctrl+Up or click the Align Top Edges  button from the Alignment toolbar.

· Press Ctrl+Down or click the Align Bottom Edges  button from the Alignment toolbar.

· Click the Align Vertical Center  button from the Alignment toolbar.
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· Click the Align Horizontal Center  button from the Alignment toolbar.

Changing the design layout
In SchemaAgent, you can change the layout of a Design window automatically. Two options are available in the
Layout sub-menu to this aim when more than one file box is selected.

To automatically change a design layout:

1. Select at least two file boxes in a Design window. 
2. Select the menu option Layout | Layout or right-click and select Align | Layout from the context

menu. A sub-menu appears.
3. Select the appropriate layout from the sub-menu. Alternatively, skip step 2 and do one of the following:

· Click the Layout using force-directed algorithm  button from the Alignment toolbar.

· Click the Layout as a hierarchy  button from the Alignment toolbar.

Lining up file boxes
Using the options in the Line Up sub-menu, you can line up the top edges of the selected file boxes with the
top edge of the file box that has the focus (when Horizontally is selected) or the left edges of the selected file
boxes with the left edge of the file box that has the focus (when Vertically is selected).

To line up file boxes:

1. Select the file boxes you want to line up.
2. Select the menu option Layout | Line Up or right-click and select Align | Line Up from the context

menu. A sub-menu appears.
3. Select from this sub-menu, how you want to line up the selected file boxes. Alternatively, skip step 2

and do one of the following:

· Press Alt+Down or click the Line up vertically  button from the Alignment toolbar.

· Press Alt+Right or click the Line up horizontally  button from the Alignment toolbar.

Changing the order of file boxes
If located in a stack of boxes you can bring a particular file box to top or bottom of this stack by selecting the
corresponding option in the Order sub-menu.

To bring a file box to the top or bottom of a stack of file boxes:

1. Select the file box you want to change the stack position of.
2. Select the menu option Layout | Order or right-click and select Align | Order from the context menu.

A sub-menu appears.
3. Select the appropriate option from the sub-menu. Alternatively, skip step 2 and do one of the following:
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· Click the Bring to Top  button from the Alignment toolbar.

· Click the Bring to Bottom  button from the Alignment toolbar.

Resizing file boxes
The Resize sub-menu provides several options to unify the appearance of file boxes in a design. The size to be
applied to all selected file boxes is taken from the file box that has the focus.

Note: Resizing height might require that components in a file box be collapsed in order to attain the height of
the file box that has the focus.

To resize file boxes:

1. Select the file boxes you want to resize, giving focus to the file box whose size you want the others to
be changed to.

2. Select the menu option Layout | Resize or right-click and select Align | Resize from the context
menu. A sub-menu appears.

3. Select the appropriate option from the sub-menu. Alternatively, skip step 2 and do one of the following:

· Click the Make same width  button from the Alignment toolbar.

· Click the Make same height  button from the Alignment toolbar.

· Click the Make same size  button from the Alignment toolbar.

Distributing file boxes evenly
Within a selection of at least three file boxes, you can use the options provided in the Space Evenly sub-menu
to arrange the files in a way that the space between them is equally distributed.

To space file boxes evenly:

1. Select three or more file boxes in a design.
2. Select the menu option Layout | Space Evenly or right-click and select Align | Space Evenly from

the context menu. A sub-menu appears.
3. Select the appropriate option from the sub-menu. Alternatively, skip step 2 and do one of the following:

· Press Ctrl+Alt+Down or click the Space evenly vertically  button from the Alignment toolbar.

· Press Ctrl+Alt+Right or click the Space evenly horizontally  button from the Alignment
toolbar.
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4.7.5.2  Sorting Files in Designs

The Sort sub-menu provides options for sorting file boxes in alphabetical order or according to their widths.

Note: Alphabetical sorting is case-sensitive.

To sort file boxes by name:

1. Select the file boxes you want to sort.
2. Select the menu option Layout | Sort or right-click and choose Sort | By Name from the context

menu. A sub-menu appears.
3. Select the appropriate option from the sub-menu. Alternatively, skip step 2 and do one of the following:

· Click the Sort by Name ascending  button from the Sort toolbar.

· Click the Sort by Name descending  button from the Sort toolbar.

To sort file boxes by width:

1. Select the file boxes you want to sort.
2. Select the menu command Layout | Sort or right-click and choose Sort | By Width from the context

menu. A sub-menu appears.
3. Select the appropriate option from the sub-menu. Alternatively, skip step 2 and do one of the following:

· Click the Sort by Width ascending  button from the Sort toolbar.

· Click the Sort by Width descending  button from the Sort toolbar.

4.7.6 Connector Options

When you right-click a connector line in a Design window, different context menus open depending on the type
of connector that has been clicked:

· When you right-click a relation, a context menu opens allowing you to select the source and/or target
file, and to delete the relation.
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· For component relations, the context menu enables you to select the source and/or target file, and
to show the relation path, that is, select the corresponding IIR relation as well as the respective file
boxes.

· The Select sub-menu is the same for both types of relation.

To select source and/or target file boxes for a relation:

· Right-click an IIR relation or a component relation and select one of the following options from the
Select sub-menu of the context menu:

· Source
· Target
· Source & Target

The corresponding file boxes are selected in the Design window.

To delete an IIR relation:

1. Do one of the following:

· Right-click an IIR connector line and select Delete from the context menu.
· Select an IIR connector line and press the Delete button.

· Select an IIR connector line and click the Delete  icon in the Standard toolbar.

A message box appears asking whether you really want to delete the selected objects.

2. To confirm the deletion, click Yes.

To show the relation path of a component relation:

· Right-click the connector line of a component relation and select Show relation path from the context
menu.

SchemaAgent will select the connector lines between the related components as well as the connector line
showing the type of relation between the schemas. If the schema box of the source or target component is
collapsed, it will be expanded to the level required to display the relation.
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4.7.7 Printing Designs

The Design diagram in the active Design window can be printed together with a header and footer that provides
meta information about the user environment and SchemaAgent application information. A print preview is
available for you to check the layout of the printed page before sending it to the printer.

To print a design:

1. Select the design you want to print.

2. Select the menu command File | Print..., or press Ctrl+P, or click the Print  button in the
Standard toolbar. The Print dialog box appears.

3. Choose the appropriate zoom factor in the Zoom group box. The Use optimal option ensures that the
design is printed on one page.

4. Optionally, define the printer setup by clicking the Print Setup button.
5. Optionally, click the Preview button to preview the print-out before actually sending it to the printer.
6. In the Page split of pictures group box, choose whether schema boxes may be split across page

breaks.
7. Click Print.

To preview a design before printing:

1. Select the design you want to preview.
2. Select the menu command File | Print Preview or File | Print..., or press Ctrl+P, or click the Print

 button in the Standard toolbar. The Print dialog box appears.
3. In the Print dialog box, click Preview.
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To change the printer setup:

1. Select the menu command File | Print Setup. The Print Setup dialog box opens.
2. Adjust settings as desired and click OK.

4.7.8 Exporting Designs as Images

You can export SchemaAgent Client designs as images in PNG format.

To export a design to a PNG image file:

1. Select the design you want to save as an image file.
2. Select the menu command File | Export to image.... The standard Windows Save As dialog box

appears.
3. Select the folder where you want to save the image. 
4. Enter the file name for the image. 
5. Click Save.
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4.8 Designing IIR Relationships

XML schemas provide three main methods of modularizing your schemas: Imports, Includes, and Redefines,
which we collectively call IIRs for short. Each of these methods has specific namespace requirements, which
are automatically checked by SchemaAgent when you create IIRs in SchemaAgent Client.

IIRs are used as follows:

· Includes are used to incorporate schema components that belong to the same target namespace or
that do not have a target namespace. In the SchemaAgent default color scheme, Includes appear as
green lines.

· Imports are used when combining schema components that belong to different namespaces. Using
Import defines the schema location, as well as the namespace for the schema. This allows the
document instance to contain both namespaces. In the SchemaAgent default color scheme, Imports
appear as blue lines.

· Redefines are used to combine and modify schema components of the same target namespace or that
do not have a target namespace. Using Redefines allows you to incorporate external schema
definitions and declarations, such as complex types, and change them in the redefining schema. In the
SchemaAgent default color scheme, Redefines appear as purple-violet lines.

In SchemaAgent's Design window, you can easily create  or modify  IIR relationships between schemas
using drag-and-drop. Please note that you cannot create a new schema file from scratch in SchemaAgent; you
can, however, add a new file in the Explorer window  and then use the context menu to edit the schema
in XMLSpy.

Note: Connectors appear as soon as a schema is inserted into the design if the inserted schema has existing
IIR relationships with other schemas present in the design.

4.8.1 Creating IIR Relations

Once you have dragged a schema  into a Design window, you can create includes, imports, and redefines
by adding the referenced schemas to the design and using drag-and-drop. To this aim, each schema or .mfd
file box has a handle located at the right border of the title bar.

To create an IIR relation:

1. Click the schema box handle of the schema from which you wish to create the IIR and drag the cursor
to the schema in which the IIR statement is to appear. If minimized, the target schema box expands,
allowing you to drop the connector onto one of the IIR entries.

2. Place the cursor over the desired IIR entry. 
3. When the desired IIR entry turns bold and a frame appears around it, drop the connector. The IIR

command has now been inserted in the schema, and a drop-down symbol appears next to the IIR
entry.
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4. Optionally, create additional IIR relationships that are allowed between schemas.

When dropping the connector onto an entry that does not turn bold, an error message appears, explaining why
the selected IIR relationship is not allowed.

4.8.2 Moving IIR Relationships

You can move existing Includes, Imports, and Redefines from one schema box to another using drag-and-drop.
If the relationship with the new schema is not valid, a message box to this effect pops up and the relation
remains unchanged.

To move an existing IIR relationship:

1. Click the connector line of the IIR relation you wish to move and drag the cursor to the schema in
which the IIR statement is to appear instead. If minimized, the target schema box expands, allowing
you to drop the connector onto one of the IIR entries. 

2. Place the cursor over the desired IIR entry.
3. When the desired IIR entry turns bold and a frame appears around it, drop the connector. The IIR

command has now been inserted in the schema, and a drop-down symbol appears next to the IIR
entry.
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4.8.3 Deleting IIR Relationships

Unwanted Includes, Imports, and Redefines can be deleted in a Design window. If a given relation cannot be
deleted, a message box pops up stating the reason of and offering a solution for the failure.

To delete an IIR relation:

1. Do one of the following:

· Right-click an IIR connector line and select Delete from the context menu.
· Select an IIR connector line and press the Delete key.

· Select an IIR connector line and click the Delete  button in the Standard toolbar.

A message box appears asking whether you really want to delete the selected objects.

2. To confirm the deletion, click Yes.
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4.9 Menu Reference

This section describes available menu commands.

4.9.1 File Menu

The File menu contains all commands relevant to manipulating files, in the order common to most Windows
software products.

New

The New  (Ctrl+N) command opens a new Design window .

Open...

The Open...  (Ctrl+O) command pops up the Windows Open dialog box and allows you to open any 
design file (*.sad). In the Open dialog box, you can select more than one file to open. Use the Files of Type
drop-down list to restrict the kind of files displayed in the dialog box.

Close
The Close command closes the active window. If the file has been modified (indicated by an asterisk * after the
file name in the title bar), you will be asked if you wish to save the file first.

Close All
The Close All command closes all open windows. If any document has been modified (indicated by an asterisk
* after the file name in the title bar), you will be asked if you wish to save the file first.

Please note that the project will not be closed by the Close All command. A project can only be closed by
opening a new project or by exiting SchemaAgent.

Save

The Save  (Ctrl+S) command saves the contents of the active window to the file from which it has been
opened. If there are unsaved changes in the active window, the Save As dialog box is opened automatically.

Save As...
The Save As... command pops up the Windows Save As dialog box, in which you enter the name and location
of the file you wish to save the active file as.

Export to image...
The Export to image... command pops up the Windows Save As dialog box, in which you can export the
active file as PNG image.
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Print...

The Print...  (Ctrl+P) command opens the Print dialog box, in which you can select printer options  and
print the active file . 

Print Preview
The Print Preview command opens the Print dialog box. Click the Preview button to display a print preview of
the currently active document.

Print Setup...
The Print Setup... command displays the printer-specific Print Setup dialog box, in which you specify such
printer settings as paper format and page orientation. These settings are applied to all subsequent print jobs.

Most Recently Used Files
The File menu displays a list of the four most recently used files, with the most recently opened file shown at
the top of the list. You can open any of these files by clicking its name. To open a file in the list using the
keyboard, press ALT+F to open the File menu, and then press the number of the file you want to open.

Exit
The Exit command is used to quit SchemaAgent Client. If you have any open files with unsaved changes, you
are prompted to save these changes. SchemaAgent Client also saves modifications to program settings and
information about the most recently used files.

4.9.2 Edit Menu

The Edit menu contains commands for editing file boxes in the Design window.

Cut

The Cut  (Shift+Delete) command copies the selected item to the clipboard and deletes it from its present
location.

Copy

The Copy  (Ctrl+C) command copies the selected item to the clipboard. This can be used to duplicate
data within SchemaAgent Client or to move data to another application.

Paste

The Paste  (Ctrl+V) command inserts the contents of the clipboard at the current cursor position.
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Delete

The function of the Delete  command depends on where the selected file is located and has the focus:

· If the focus is in a Design window, the selected file is removed from the design.
· If the focus is in the Explorer window, the selected file is deleted from the file system. You will have to

confirm the command before the file is actually deleted.

Recreate
The Recreate commands creates a new file with the name of the ghost schema as a rudimentary schema at
the location specified in the reference. This command is available only if a ghost schema  is selected either
in the Explorer window or in a Design window.

Synchronize Selection

The Synchronize Selection  command synchronizes the selected files in the Explorer and the active
Design window. It works from both sides, that is, you can select a file in the Explorer and use the command to
select the corresponding file box in the active Design window or vice versa.

Note: The Synchronize Selection command works only for the active Design window. If you select a file in
the Explorer that is contained in a Design window that is not currently active, choosing the Synchronize
Selection command has no effect.

Select
The Select sub-menu contains options for selecting files in the active Design window. See also Selecting
Files , Directly Related Files , Indirectly Related Files , and Linked Files .

4.9.3 View Menu

The View menu contains commands for showing and hiding the individual toolbars and the status bar.

Toolbars
The Toolbars sub-menu enables you to show or hide the individual toolbars by activating or deactivating the
corresponding entry in the menu.

To switch the display of toolbars on or off:

1. Select the menu option View | Toolbars.
2. Click the name of the toolbar you want to switch on or off.

Explorer
You can choose to show or hide the Explorer window.
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Overview
You can show or hide the Overview window located under the Explorer window.

Status bar
The Status Bar command toggles the display of the status bar in SchemaAgent Client on and off. To switch
the display of the status bar on or off, select the menu option View | Status Bar. 

4.9.4 Layout Menu

The Layout menu provides a variety of features for changing the appearance of your designs.

Show Grid

The Show Grid  (Alt+G) command toggles the display of the grid on and off for the active Design window.
You can show or hide the grid for each Design window individually.

Align on Grid

When the grid is displayed, you can use the Align on Grid  command to align the top and left edges of
schema or .mfd file boxes on the grid.

Zoom
The Zoom sub-menu provides commands for zooming in and out of a design view as well as adjusting the
zoom in a way that all file boxes or the selected file boxes are displayed in the Design window. To adjust the
zoom to one of the predefined values, select one of the options at the bottom of the menu.

Zoom... 
Shows the Zoom dialog box, where you can use the slider to adjust the zoom
or enter a specific zoom factor.

Zoom to Fit 
Adjusts the zoom factor in a way that all file boxes that are present in the
active design are displayed in the Design window without the need of
scrolling.

Zoom to Selection 
Adjusts the zoom factor in a way that all the selected file boxes are displayed
in the Design window without the need of scrolling.

Layout
The Layout sub-menu provides commands that facilitate an automatic layout of the file boxes in a Design
window.

Force Directed 
Uses a force-directed algorithm to automatically layout the file boxes in a
Design window. You may have to use the Layout | Zoom to Fit command to
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view all the file boxes.

Hierarchical 
Layouts the file boxes in a hierarchical manner.

Force-directed layout

Hierarchical layout

Align Edges
The Align Edges sub-menu can be used to align selected file boxes on the grid of a Design window. When
selecting files for aligning, make sure that the focus is set on the right file box because all the files will be
aligned with the file box that has the focus.

 Left (Ctrl+Left)
Aligns the left edges of the selected file boxes. The selected file boxes will be
left-aligned at the position of the file box that has the focus.
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 Right (Ctrl+Right)
Aligns the right edges of the selected file boxes. The selected file boxes will
be right-aligned at the position of the file box that has the focus.

 Top (Ctrl+Up)
Aligns the top edges of the selected file boxes. The selected file boxes will be
aligned at the position of the top edge of the file box that has the focus.

 Bottom (Ctrl+Down)
Aligns the bottom edges of the selected file boxes. The selected file boxes
will be aligned at the position of the bottom edge of the file box that has the
focus.

 Center Vertical
Aligns the vertical center of the selected file boxes. The center of the selected
file boxes will be aligned vertically at the position of the file that has the focus.

 Center Horizontal
Aligns the horizontal center of the selected file boxes. The center of the
selected file boxes will be aligned horizontally at the position of the file that
has the focus.

Line Up
The Line Up sub-menu enables you to line up the selected file boxes vertically or horizontally below or to the
right of the focused item.

 Vertically (Alt+Down)
Arranges the selected file boxes in a vertical row, left-aligned and below the
file box that has the focus.

 Horizontally
(Alt+Right)

Arranges the selected file boxes in a horizontal row, top-aligned and to the
right of the file box that has the focus.

Order
The Order sub-menu allows you to bring the selected file box to the top or send it to the bottom of a stack of
file boxes.

 Bring to top
Displays the selected file box on top of a stack of file boxes.

 Bring to bottom
Sends the selected file to the bottom of a stack of file boxes.

Resize
The Resize sub-menu provides options allowing you to unify the graphical appearance of your design files. Be
sure to choose the right file when setting the focus. All selected files inherit the dimensions of the file that has
the focus.

Make same width
Applies the width of the focused file box to all selected file boxes.

Make same height
Applies the height of the focused file box to all selected file boxes.
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Make same size
Applies the width and height of the focused item to all selected file boxes.

Space Evenly
The Space Evenly sub-menu enables you to distribute a series of selected file boxes evenly between the top
and bottom or left and right edges of the selection, respectively. You can also use the commands subsequently
to create a vertical and horizontal balance.

 Vertically (Ctrl+Alt+Down)
Arranges the selected files to provide for an equal distance of the files
located in between the topmost and the bottommost file boxes.

 Horizontally
(Ctrl+Alt+Right)

Arranges the selected files to provide for an equal distance of the files
located in between the leftmost and the rightmost file boxes.

Sort
The Sort sub-menu allows you to sort file boxes by name or by width, in ascending or descending sort order.
The positions of the selected file boxes (specifically, the top and left edges) remain unchanged when one of the
Ascending or Descending commands is used.

 Ascending | By Name
The selected file boxes are sorted alphabetically with the file name closest to
letter A on top.

 Ascending  | By
Width

The selected file boxes are sorted by width with the smallest file box on top
and the widest file box on bottom.

 Descending | By
Name

The selected file boxes are sorted alphabetically with the file name closest to
letter Z on top.

 Descending | By
Width

The selected file boxes are sorted by width with the widest file box on top and
the smallest file box on bottom.

4.9.5 Extras Menu

In the Extras menu, you connect to a SchemaAgent Server, reload the search paths, and correct reference
paths to ghost schemas for selected or all schema boxes.

Connect to Server

The Connect to server  command opens the Connect to SchemaAgent Server dialog box where you can
connect to a SchemaAgent server .70
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Reload Search Paths

The Reload search paths  command enables you to update the graphical user interface of the application
when any of the files on the search path (or the search paths themselves) have changed, see Reloading Search
Paths .

Correct Reference Paths

The Correct reference paths  (Ctrl+R) command attempts to find alternative locations for referenced files

that cannot be found. You have to select a schema box with an alert  icon in a Design window or in the
Explorer in order to enable this command in the Extras menu. See Ghost Schemas and Incorrect Paths .

Correct all Reference Paths

The Correct all reference paths  command attempts to find alternative locations for all referenced files
that cannot be found. See Correcting multiple paths .

4.9.6 Tools Menu

The Tools menu lets you customize SchemaAgent Client and define the global program settings.

4.9.6.1  Customize...

The Customize command lets you customize SchemaAgent Client to suit your personal needs.
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111

113



138 SchemaAgent Client Menu Reference

© 2019-2025 Altova GmbHAltova SchemaAgent 2025

4.9.6.1.1     Commands

The Commands tab enables you to customize menus or toolbars.

To add a command to a toolbar or menu:

1. Select the menu option Tools | Customize. The Customize dialog box appears.
2. Select the All Commands category in the Categories list box. The available commands appear in the

Commands list box.
3. Click a command in the Commands list box and drag it to an existing menu or toolbar. An I-beam

appears when you place the cursor over a valid position to drop the command.
4. Release the mouse button at the position you want to insert the command.

· A small button appears at the tip of mouse pointer when you drag a command. The "x" below the
pointer means that the command cannot be dropped at the current cursor position.

· The "x" disappears whenever you can drop the command (over a tool bar or menu).
· Placing the cursor over a menu when dragging opens it, allowing you to insert the command

anywhere in the menu.
· Commands can be placed in menus or toolbars. If you created you own toolbar you can populate it

with your own commands/icons.

Note: You can also edit the commands in the context menus  (right-click anywhere to open the context
menu), using the same method. Click the Menu tab and then select the specific context menu available in the
Context Menus combo box.
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4.9.6.1.2     Toolbars

The Toolbars tab enables you to activate or deactivate specific toolbars, as well as create your own
specialized ones.

SchemaAgent Client toolbars contain symbols for the most frequently used menu commands. For each symbol
you get a brief "tool tip" explanation when the mouse cursor is directly over the item and the status bar shows
a more detailed description of the command.

You can drag the toolbars from their standard position to any location on the screen, where they appear as a
floating window. Alternatively, you can also dock them to the left or right edge of the main window.

Select the Show text labels option to display explanatory text below toolbar icons. You can select or clear
this option for each toolbar individually.

To activate or deactivate a toolbar:

· Click or clear the check box corresponding to the specific toolbar.

To create a new toolbar:

1. Click the New... button, and give the toolbar a name in the dialog box that appears.
2. Drag commands to the toolbar in the Commands  tab of the Customize dialog box.138
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To reset the Menu Bar:

1. Click the Menu Bar entry.
2. Click the Reset button, to reset the menu commands to the state they were in when SchemaAgent

Client was installed.

To reset all toolbar and menu commands:

1. Click the Reset All button to reset all the toolbar commands to the state they were when the program
was installed. A dialog box appears stating that all toolbars and menus will be reset.

2. Click Yes to confirm the reset.

To change a toolbar name:

· Click the Rename... button to edit the name of the toolbar.

This option is available only for user-defined toolbars.

To delete a toolbar:

1. Select the toolbar you want to delete in the Toolbars list box.
2. Click the Delete button. A message box appears, asking if you really want to delete the toolbar.
3. Click Yes to confirm the deletion.

This option is available only for user-defined toolbars.

4.9.6.1.3     Tools

The Tools tab enables you to add custom menu items, such as shortcuts to other applications, to the Tools
menu. Any user-defined entries will appear in the Tools menu.
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To add a user-defined tool:

1. Click the New  icon or press the Insert key.
2. In the text field that appears, enter the string that is to appear as menu entry in the Tools menu.
3. In the Command field, enter the path to the executable file of the application or use the browse button

to select the path.
4. If applicable, enter arguments needed to start the application in the Arguments field.
5. If applicable, enter the path to the directory that should be used as current (initial) directory when the

tool initializes.

To change the sequence of user-defined tools:

· Select an entry and use the Move Item Up  and Move Item Down  buttons to move the menu
item. Alternatively, you can also use the shortcut keys Alt+Up and Alt+Down to move the entry.

To rename a user-defined menu item:

· Double-click an item in the Menu contents field and edit the entry.
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To remove a user-defined tool:

· Select the entry you want to remove from the Tools menu and click the Delete  icon in the Menu
contents title bar or press the Delete key.

4.9.6.1.4     Keyboard

The Keyboard tab enables you to define (or change) keyboard shortcuts for any SchemaAgent Client
command.

To assign a new shortcut to a command:

1. Select the All Commands category from the Category drop-down list.
2. In the Set accelerator for drop-down list, select one of the following, as applicable:

· Default – this option enables the shortcut regardless of whether the Design window is open or not.
· SchemaAgent Design – the shortcut will work only if the Design window is open.

3. Select the command you want to assign a new shortcut to, in the Commands list box.
4. Click in the Press New Shortcut Key text box, and press the shortcut keys that are to activate the

command. The shortcuts appear immediately in the text box. If the shortcut was assigned previously,
then that function is displayed below the text box.
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5. Click the Assign button to assign the shortcut. The shortcut now appears in the Current Keys list box.
(To clear this text box, press any of the control keys, Ctrl, Alt or Shift).

To de-assign or delete a shortcut:

1. Click the shortcut you want to delete in the Current Keys list box.
2. Click the Remove button.
3. Click the Close button to confirm.

To reset all shortcut keys:

1. Click the Reset All button to reset all the shortcut keys to the state they were when the program was
installed. A prompt appears stating that all toolbars and menus will be reset.

2. Click Yes to confirm the reset.

The following tables list the currently assigned keyboard shortcuts by key and by function, respectively.

Hotkeys by key

Shortcut Command name

F1 Help

Delete Delete

Shift+Delete Cut

Ctrl+Insert Copy

Shift+Insert Paste

Ctrl+Down Align Edges Bottom

Alt+Down Line Up Vertically

Ctrl+Alt+Down Space Evenly Vertically

Ctrl+Left Align Edges Left

Ctrl+Right Align Edges Right

Alt+Right Line Up Horizontally

Ctrl+Alt+Right Space Evenly Horizontally

Ctrl+Up Align Edges Top

Ctrl+A Select All

Ctrl+C Copy

Ctrl+N New
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Shortcut Command name

Ctrl+O Open

Ctrl+P Print

Ctrl+R Correct Reference Paths

Ctrl+S Save

Ctrl+V Paste

Ctrl+X Cut

Alt+G Show Grid

Hotkeys by function

Command name Shortcut Alternative shortcut

Align Edges Bottom Ctrl+Down

Align Edges Left Ctrl+Left

Align Edges Right Ctrl+Right

Align Edges Top Ctrl+Up

Copy Ctrl+C Ctrl+Insert

Correct Reference Paths Ctrl+R

Cut Ctrl+X Shift+Delete

Delete Delete

Help F1

Line Up Horizontally Alt+Right

Line Up Vertically Alt+Down

New Ctrl+N

Open Ctrl+O

Paste Ctrl+V Shift+Insert

Print Ctrl+P

Save Ctrl+S

Select All Ctrl+A

Show Grid Alt+G
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Command name Shortcut Alternative shortcut

Space Evenly Horizontally Ctrl+Alt+Right

Space Evenly Vertically Ctrl+Alt+Down

4.9.6.1.5     Menu

The Menu tab enables you to customize the menu bars as well as the context menus.

Customizing menus
The Default Menu bar is the menu bar that is displayed when no Design windows are open. The Schema
Agent design menu bar is the menu bar that is displayed when at least one Design window is open. Each
menu bar can be customized separately, and customization changes made to one do not affect the other.

To customize a menu bar, select it from the Show Menus For drop-down list. Then click the Commands tab
and drag commands from the Commands list box to the menu bar or into any of the menus.

Deleting commands from menus and resetting the menu bars
To delete an entire menu or a command inside a menu, do the following:

1. Select from the Show Menus for drop-down list the menu bar that is to be customized.
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2. With the Customize dialog open, select (i) the menu you want to delete from the application's menu
bar, or (ii) the command you want to delete from one of these menus.

3. Either (i) drag the menu from the menu bar or the menu command from the menu, or (ii) right-click the
menu or menu command and select Delete.

You can reset any menu bar to its original installation state by selecting it from the Show Menus For drop-
down list and then clicking the Reset button.

Customizing the application's context menus
Context menus are the menus that appear when you right-click certain objects in the application's interface.
Each of these context menus can be customized by doing the following:

1. Select the context menu from the Select context menu drop-down list. This pops up the context
menu.

2. Click the Commands tab.
3. Drag a command from the Commands list box into the context menu.
4. To delete a command from the context menu, right-click that command in the context menu, and

select Delete. Alternatively, drag the command out of the context menu.

You can reset any context menu to its original installation state by selecting it in the Select context menu
drop-down list and then clicking the Reset button.

Menu shadows
Select the Menu shadows check box to give all menus shadows.

You can choose from among several menu animations if you prefer animated menus. The Menu animations
drop-down list provides the following options:

· None (default)
· Unfold
· Slide
· Fade
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4.9.6.1.6     Options

The Options tab enables you to set miscellaneous environment settings.

When selected, the Show ScreenTips on toolbars check box displays a tooltip when the mouse pointer is
placed over any of the toolbar buttons. The tooltip contains a short description of the icon function, as well as
the associated keyboard shortcut, if one has been assigned.

The Show shortcut keys in ScreenTips check box allows you to decide whether or not you want to have the
shortcut displayed in the tooltip.

The Large icons check box switches between the standard size icons, and larger versions of the icons.

4.9.6.2  Restore Toolbars and Windows

This menu command resets the toolbars, entry helper windows, docked windows etc. to their defaults.
SchemaAgent needs to be restarted for the changes to take effect.

4.9.6.3  Options...

The Tools | Options command enables you to define global application settings. These settings are specified
in a tabbed dialog box and saved in the registry. They apply to all current and future document windows. The
Apply button applies changes immediately in the currently open documents.
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4.9.6.3.1     Design

The Design tab enables you to customize the way file boxes are presented in Design windows.

Move & Resize
If the Enable real time dragging check box is selected, the design is permanently redrawn while a file box is
being dragged. If the check box is not selected, the file box remains at its original position while the file box is
being dragged, and moves to the new position only when the mouse button is released. While being dragged,
the new position of the file box is shown in outline.

In the Threshold (Items) field, you can enter the maximum number of selected file boxes that are shown with
its contents while being dragged. If the number of file boxes selected is above that limit, then the selected file
boxes are shown in outline while being dragged.

Grid
The Enable grid check box sets the default appearance of new Design windows. Use the Grid size field to
define the width of the grid. 
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Note: The settings of Design windows that are already open are not updated immediately. To hide or display

the grid for an active Design window, click the Enable/Disable grid  toolbar button or use the shortcut key
Alt+G.

Component Relations
If the Auto expand check box is selected, SchemaAgent will automatically expand the details tree to the
source and target component when you click on a component relation. Note that the globals section in both
source and target schema have to be expanded in order to see the component relations.

Line up and Hierarchical Layout
In the Line up and Hierarchical Layout group boxes, you can enter the default horizontal and vertical spacing
for lining up file boxes or arranging them in the hierarchical layout, respectively.

Size
The default expand height is the height of a file box when it is expanded.

Default Insert Action
A "selection" is the list of files or folders that you drag from the Hierarchical or Flat tabs into the Design
window. You can choose from the Default Insert Action drop-down box all the categories of dependent files
that should be added automatically to the design in addition to the current selection. The default value is
selection only.

Auto-layout
The following layout options are available when several files or folders are dragged into a design window:

· Default layout
· Force-directed layout
· Hierarchical layout

The Default layout option arranges the file boxes alphabetically in the design.

Component File Paths
Select the Use relative file paths... check box if components in a design should be saved with a path relative
to the .sad design file.

133

134



150 SchemaAgent Client Menu Reference

© 2019-2025 Altova GmbHAltova SchemaAgent 2025

4.9.6.3.2     Fonts

The Fonts tab enables you to customize the appearance of text in SchemaAgent designs. You can restore the
default settings at any time by clicking the Restore default values button.

Font face and script
You can select the font face and size to be used for displaying the various items in the Design view. The same
fonts are used when printing, so only TrueType fonts should be selected. If you want to use the same font for all
items, select the Use the same for all check box.

Size
Select the required size. If you want to use the same font size for all items, select the Use the same for all
check box.

Styles
The style and color can be set using the options in this group box. The current settings are immediately
reflected in the list in the left pane, so you can preview the way your design will look.

4.9.6.3.3     Colors

The Colors tab enables you to customize the colors used in the Design window. You can restore the default
settings at any time by clicking the Restore default values button.
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Background Colors
This group box allows you to define the colors for a gradient background as well as the orientation of the
gradient.
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Connector Colors
The color in the Connection Colors group box refers to the arrowheads to the left and right of a file box. You can
define different colors for empty connectors and for connectors combining several different types of
connections. The color of the connector lines itself is defined in the Connection colors  group box.

Font Colors
Here you define the font color for the different types of text in SchemaAgent Client. The font itself as well as
font size and style are defined in the Fonts  tab.

Color Scheme
The Color Scheme group box provides a drop-down list where you can select any of the following for editing:

· XML Schema
· XML instance
· Stylesheet Transformation
· Web Services Description
· MapForce Design

Individual group boxes are available where you can change the colors for the title bar when it is unselected or
selected and the colors for the sub-bars, that is, the titles of the individual sections of a file box.

Connection Colors
The color in the Connection Colors group box refers to the connection line itself. Depending on the selection in
the Color Scheme drop-down list, different options are available:

· XML Schema: Include, Import, Redefine
· XML Instance: Schema, Stylesheet
· Stylesheet Transformation: Include Stylesheet, Import Stylesheet, Import Schema, Inline Schema
· Web Services Description: Import WSDL, Import Schema, Inline Schema
· MapForce Design: Schema, Instance, WSDL

4.9.6.3.4     Relations

The Relations tab enables you to customize the appearance of the connection lines between file boxes in
SchemaAgent designs. You can restore the default settings at any time by clicking the Restore default
values button.
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You can define the line width as well as the line style for both file and component relations in either of the
following states:

· Normal
· Selected
· Highlighted

For the line width, you can enter integers between 1 and 10.

93
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4.9.6.3.5     Miscellaneous

On the Miscellaneous tab, you can define start-up, shutdown, and caching options.

SchemaAgent LocalServer
To add SchemaAgent LocalServer to the Windows Start-up folder, select the Startup during user login (Add
to Startup folder) check box. In this case, SchemaAgent LocalServer will be started each time a user logs in
to Windows.

If you select the Shutdown on disconnect of last client check box, SchemaAgent LocalServer will
automatically shut down as soon as the last client disconnects from SchemaAgent Client.

SchemaAgent's caching of globals and components for
For each of the available servers, you can define whether or not data should be cached. If data is cached by a
SchemaAgent server, more memory is used but communication frequency is lower.

4.9.6.3.6     Help

Application provides Help (the user manual) in two formats:

· Online Help, in HTML format, which is available at the Altova website. In order to access the Online
Help you will need Internet access.

· A Help file in PDF format, which is installed on your machine when you install Application. It is named
Application.pdf and is located in the application folder (in the Program Files folder). If you do not

have Internet access, you can always open this locally saved Help fie.

The Help option (screenshot below) enables you to select which of the two formats is opened when you click
the Help (F1) command in the Help menu.
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You can change this option at any time for the new selection to take effect. The links in this section (see
screenshot above) open the respective Help format.

4.9.7 Window Menu

To organize the individual windows in a SchemaAgent Client session, the Window menu contains standard
commands common to most Windows applications. 

Cascade

The Cascade  command rearranges all open document windows so that they are all cascaded (staggered)
on top of each other.

Tile Horizontally

The Tile horizontally  command rearranges all open document windows as horizontal tiles, making them
all visible at the same time.

Tile Vertically

The Tile vertically  command rearranges all open document windows as vertical tiles, making them all
visible at the same time.

Currently Open Window List
This list shows all currently open design windows and lets you quickly switch between them. You can also use
the Ctrl+Tab or Ctrl+F6 keyboard shortcuts to cycle through the open windows.

4.9.8 Help Menu

This section describes all the menu commands available in the Help menu.

Help (F1)

The Help (F1) command opens the application's Help documentation (its user manual). By default, the
Online Help in HTML format at the Altova website will be opened.

If you do not have Internet access or do not want, for some other reason, to access the Online Help, you
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can use the locally stored version of the user manual. The local version is a PDF file named
Application.pdf that is stored in the application folder (in the Program Files folder).

If you want to change the default format to open (Online Help or local PDF), do this in the Help section of
the Options dialog (menu command Tools | Options).

Software Activation

License your product
After you download your Altova product software, you can license—or activate—it using either a free
evaluation key or a purchased permanent license key.

· Free evaluation license. When you first start the software after downloading and installing it, the
Software Activation dialog will pop up. In it is a button to request a free evaluation license. Click
it to get your license. When you click this button, your machine-ID will be hashed and sent to
Altova via HTTPS. The license information will be sent back to the machine via an HTTP response.
If the license is created successfully, a dialog to this effect will appear in your Altova application.
On clicking OK in this dialog, the software will be activated for a period of 30 days on this
particular machine.

· Permanent license key. The Software Activation dialog allows you to purchase a permanent
license key. Clicking this button takes you to Altova's online shop, where you can purchase a
permanent license key for your product. Your license will be sent to you by e-mail in the form of a
license file, which contains your license-data. 

There are three types of permanent license: installed, concurrent user, and named user. An
installed license unlocks the software on a single computer. If you buy an installed license for N
computers, then the license allows use of the software on up to N computers. A concurrent-user
license for N concurrent users allows N users to run the software concurrently. (The software may
be installed on 10N computers.)  A named-user license authorizes a specific user to use the
software on up to 5 different computers. To activate your software, click Upload a New License,
and, in the dialog that appears, enter the path to the license file, and click OK.

Note: For multi-user licenses, each user will be prompted to enter his or her own name.

Your license email and the different ways to license (activate) your Altova product 
The license email that you receive from Altova will contain your license file as an attachment.
The license file has a .altova_licenses file extension.

To activate your Altova product, you can do one of the following:

· Save the license file (.altova_licenses) to a suitable location, double-click the

license file, enter any requested details in the dialog that appears, and finish by
clicking Apply Keys.

· Save the license file (.altova_licenses) to a suitable location. In your Altova

product, select the menu command Help | Software Activation, and then Upload a
New License. Browse for or enter the path to the license file, and click OK.

· Save the license file (.altova_licenses) to any suitable location, and upload it from

this location to the license pool of your Altova LicenseServer. You can then either: (i)
acquire the license from your Altova product via the product's Software Activation

https://www.altova.com/licenseserver
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dialog (see below) or (ii) assign the license to the product from Altova LicenseServer.
For more information about licensing via LicenseServer, read the rest of this topic. 

You can access the Software Activation dialog (screenshot below) at any time by clicking the Help |
Software Activation command.

Activate your software
You can activate the software by registering the license in the Software Activation dialog or by licensing via
Altova LicenseServer (see details below).

· Registering the license in the Software Activation dialog. In the dialog, click Upload a New
License and browse for the license file. Click OK to confirm the path to the license file and to
confirm any data you entered (your name in the case of multi-user licenses). Finish by clicking
Save.

· Licensing via Altova LicenseServer on your network : To acquire a license via an Altova
LicenseServer on your network, click Use Altova LicenseServer, located at the bottom of the
Software Activation dialog. Select the machine on which the LicenseServer you want to use has
been installed. Note that the auto-discovery of License Servers works by means of a broadcast
sent out on the LAN. As these broadcasts are limited to a subnet, License Server must be on the
same subnet as the client machine for auto-discovery to work. If auto-discovery does not work,
then type in the name of the server. The Altova LicenseServer must have a license for your Altova
product in its license pool. If a license is available in the LicenseServer pool, this is indicated in
the Software Activation dialog (see screenshot below showing the dialog in Altova XMLSpy).
Click Save to acquire the license.

https://www.altova.com/licenseserver
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After a machine-specific (aka installed) license has been acquired from LicenseServer, it cannot
be returned to LicenseServer for a period of seven days. After that time, you can return the
machine license to LicenseServer (click Return License) so that this license can be acquired
from LicenseServer by another client. (A LicenseServer administrator, however, can unassign an
acquired license at any time via the administrator's Web UI of LicenseServer.) Note that the
returning of licenses applies only to machine-specific licenses, not to concurrent licenses.

Check out license
You can check out a license from the license pool for a period of up to 30 days so that the license
is stored on the product machine. This enables you to work offline, which is useful, for example, if
you wish to work in an environment where there is no access to your Altova LicenseServer (such
as when your Altova product is installed on a laptop and you are traveling). While the license is
checked out, LicenseServer displays the license as being in use, and the license cannot be used
by any other machine. The license automatically reverts to the checked-in state when the check-
out period ends. Alternatively, a checked-out license can be checked in at any time via the Check
in button of the Software Activation dialog.

To check out a license, do the following: (i) In the Software Activation dialog, click Check out
License (see screenshot above); (ii) In the License Check-out dialog that appears, select the
check-out period you want and click Check out. The license will be checked out. After checking
out a license, two things happen: (i) The Software Activation dialog will display the check-out
information, including the time when the check-out period ends; (ii) The Check out License
button in the dialog changes to a Check In button. You can check the license in again at any
time by clicking Check In. Because the license automatically reverts to the checked-in status
after the check-out period elapses, make sure that the check-out period you select adequately
covers the period during which you will be working offline.

If the license being checked out is a Installed User license or Concurrent User license, then the
license is checked out to the machine and is available to the user who checked out the license. If
the license being checked out is a Named User license, then the license is checked out to the
Windows account of the named user. License check-out will work for virtual machines, but not for
virtual desktop (in a VDI). Note that, when a Named User license is checked out, the data to
identify that license check-out is stored in the user's profile. For license check-out to work, the
user's profile must be stored on the local machine that will be used for offline work. If the user's
profile is stored at a non-local location (such as a file-share), then the checkout will be reported as
invalid when the user tries to start the Altova application.

License check-ins must be to the same major version of the Altova product from which the license
was checked out. So make sure to check in a license before you upgrade your Altova product to
the next major version.

Note:   For license check-outs to be possible, the check-out functionality must be enabled on
LicenseServer. If this functionality has not been enabled, you will get an error message to this
effect when you try to check out. In this event, contact your LicenseServer administrator.

Copy Support Code
Click Copy Support Code to copy license details to the clipboard. This is the data that you will
need to provide when requesting support via the online support form.

Altova LicenseServer provides IT administrators with a real-time overview of all Altova licenses on a
network, together with the details of each license as well as client assignments and client usage of
licenses. The advantage of using LicenseServer therefore lies in administrative features it offers for large-

https://www.altova.com/support
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volume Altova license management. Altova LicenseServer is available free of cost from the Altova website.
For more information about Altova LicenseServer and licensing via Altova LicenseServer, see the Altova
LicenseServer documentation.

Order Form

When you are ready to order a licensed version of the software product, you can use either the Purchase
a Permanent License Key button in the Software Activation dialog (see previous section) or the Order
Form command to proceed to the secure Altova Online Shop.

Registration

Opens the Altova Product Registration page in a tab of your browser. Registering your Altova software will
help ensure that you are always kept up to date with the latest product information.

Check for Updates

Checks with the Altova server whether a newer version than yours is currently available and displays a
message accordingly.

Support Center

A link to the Altova Support Center on the Internet. The Support Center provides FAQs, discussion forums
where problems are discussed, and access to Altova's technical support staff.

Download Components and Free Tools

A link to Altova's Component Download Center on the Internet. From here you can download a variety of
companion software to use with Altova products. Such software ranges from XSLT and XSL-FO processors
to Application Server Platforms. The software available at the Component Download Center is typically free
of charge.

Application on the Internet

A link to the Altova website on the Internet. You can learn more about Application, related technologies
and products on the Altova website.

About Application

Displays the splash window and version number of your product. If you are using the 64-bit version of
Application, this is indicated with the suffix (x64) after the application name. There is no suffix for the 32-bit
version.

https://www.altova.com/
https://www.altova.com/manual/en/licenseserver/3.17/
https://www.altova.com/manual/en/licenseserver/3.17/
https://www.altova.com/
https://www.altova.com/
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5 License Information

This section contains information about:

· the distribution of this software product 
· software activation and license metering
· the license agreement governing the use of this product

Please read this information carefully. It is binding upon you since you agreed to these terms when you
installed this software product.

To view the terms of any Altova license, go to the Altova Legal Information page at the Altova website.

https://www.altova.com/legal
https://www.altova.com/
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5.1 Electronic Software Distribution

This product is available through electronic software distribution, a distribution method that provides the
following unique benefits:

· You can evaluate the software free-of-charge for 30 days before making a purchasing decision. (Note:
Altova MobileTogether Designer is licensed free of charge.)

· Once you decide to buy the software, you can place your order online at the Altova website and get a
fully licensed product within minutes.

· When you place an online order, you always get the latest version of our software.
· The product package includes an onscreen help system that can be accessed from within the

application interface. The latest version of the user manual is available at www.altova.com in (i) HTML
format for online browsing, and (ii) PDF format for download (and to print if you prefer to have the
documentation on paper).

30-day evaluation period
After downloading this product, you can evaluate it for a period of up to 30 days free of charge. About 20 days
into the evaluation period, the software will start to remind you that it has not yet been licensed. The reminder
message will be displayed once each time you start the application. If you would like to continue using the
program after the 30-day evaluation period, you must purchase a product license, which is delivered in the form
of a license file containing a key code. Unlock the product by uploading the license file in the Software
Activation dialog of your product.

You can purchase product licenses at https://shop.altova.com/. 

Helping Others within Your Organization to Evaluate the Software
If you wish to distribute the evaluation version within your company network, or if you plan to use it on a PC that
is not connected to the Internet, you may distribute only the installer file, provided that this file is not modified in
any way. Any person who accesses the software installer that you have provided must request their own 30-
day evaluation license key code and after expiration of their evaluation period, must also purchase a license in
order to be able to continue using the product.

https://shop.altova.com/
https://www.altova.com/documentation
https://shop.altova.com/
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5.2 Software Activation and License Metering

As part of Altova’s Software Activation, the software may use your internal network and Internet connection for
the purpose of transmitting license-related data at the time of installation, registration, use, or update to an
Altova-operated license server and validating the authenticity of the license-related data in order to protect
Altova against unlicensed or illegal use of the software and to improve customer service. Activation is based on
the exchange of license related data such as operating system, IP address, date/time, software version, and
computer name, along with other information between your computer and an Altova license server.

Your Altova product has a built-in license metering module that further helps you avoid any unintentional
violation of the End User License Agreement. Your product is licensed either as a single-user or multi-user
installation, and the license-metering module makes sure that no more than the licensed number of users use
the application concurrently.

This license-metering technology uses your local area network (LAN) to communicate between instances of the
application running on different computers.

Single license 
When the application starts up, as part of the license metering process, the software sends a short broadcast
datagram to find any other instance of the product running on another computer in the same network segment.
If it doesn't get any response, it will open a port for listening to other instances of the application.

Multi-user license
If more than one instance of the application is used within the same LAN, these instances will briefly
communicate with each other on startup. These instances exchange key-codes in order to help you to better
determine that the number of concurrent licenses purchased is not accidentally violated. This is the same kind
of license metering technology that is common in the Unix world and with a number of database development
tools. It allows Altova customers to purchase reasonably-priced concurrent-use multi-user licenses.

We have also designed the applications so that they send few and small network packets so as to not put a
burden on your network. The TCP/IP ports (2799) used by your Altova product are officially registered with the
IANA (see the IANA Service Name Registry for details) and our license-metering module is tested and proven
technology.

If you are using a firewall, you may notice communications on port 2799 between the computers that are
running Altova products. You are, of course, free to block such traffic between different groups in your
organization, as long as you can ensure by other means, that your license agreement is not violated.

Note about certificates
Your Altova application contacts the Altova licensing server (link.altova.com) via HTTPS. For this
communication, Altova uses a registered SSL certificate. If this certificate is replaced (for example, by your IT
department or an external agency), then your Altova application will warn you about the connection being
insecure. You could use the replacement certificate to start your Altova application, but you would be doing this
at your own risk. If you see a Non-secure connection warning message, check the origin of the certificate and
consult your IT team (who would be able to decide whether the interception and replacement of the Altova
certificate should continue or not).

http://www.iana.org/assignments/service-names-port-numbers/service-names-port-numbers.xhtml
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If your organization needs to use its own certificate (for example, to monitor communication to and from client
machines), then we recommend that you install Altova's free license management software, Altova
LicenseServer, on your network. Under this setup, client machines can continue to use your organization's
certificates, while Altova LicenseServer can be allowed to use the Altova certificate for communication with
Altova.

https://www.altova.com/licenseserver
https://www.altova.com/licenseserver
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5.3 Altova End-User License Agreement

· The Altova End-User License Agreement is available here: https://www.altova.com/legal/eula 
· Altova's Privacy Policy is available here: https://www.altova.com/privacy 

https://www.altova.com/legal/eula
https://www.altova.com/privacy
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5.4 Packaging License Files with Application Installer

If you want to perform a silent installation of Application, you may want to modify the MSI database so that it
includes your license file(s). This way, the installer will not only install the product but also license it. For
details about how to achieve this, download this ZIP file from the Altova website and open the PDF document in
it.

https://www.altova.com/documents/AltovaProducts_SilentInstallWithLicense.zip
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MFD file,

creating, 73

MFD file boxes,

aligning, 120

aligning on grid, 76

arraning, 83

auto-sizing, 83

changing order, 120

collapsing structure, 83

expanding structure, 83

lining up, 120

resizing, 120

MFD files,

deleting, 75

displaying relations, 98

editing, 75

inserting, 79

Quick information, 105

reloading, 115

renaming, 74

toggling input/output instances, 98

viewing relations, 98

Moving,

IIR relationships, 128

relations, 128

N
Navigating,

within Design window, 83

O
Opening,

Design window (tutorial), 26

designs, 78

SAD files, 78

Options,

color, 150

customizing, 147

design, 148

fonts, 150

for connectors, 123

logging, 60

miscellaneous, 154

relations, 152

Order,

of related XSLTs, 94

Overview window, 67

P
Pasting,

selection, 109

Previewing,

designs, 125

Printing,

designs, 125
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displaying, 105

for component relations, 105

for MapForce design files, 105

for MFD files, 105

for relations, 105

for schemas, 105

showing, 105

viewing, 105

R
Recreating,

ghost schemas, 114

Redefining,

types using XMLSpy (tutorial), 34

Referenced files,

directly, 80

indirectly, 81

Referencing files,

directly, 80

indirectly, 81

Related components,

displaying, 98

showing, 98

viewing, 98

Relations,

designing, 127

directly referenced, 80

directly referencing, 80

displaying, 90

indirectly referenced, 81

indirectly referencing, 81

linked, 82

MapForce Design relations, 98

MFD file relations, 98

schemas, 93

showing, 90

stylesheets, 94

viewing, 90

WSDL files, 97

XML instances, 94

XML schemas, 93

XSLT stylesheets, 94

Relationships,

creating (tutorial), 26

imports (tutorial), 29

includes (tutorial), 26

redefines (tutorial), 28

viewing updates (tutorial), 45

Reloading,

files, 115

MapForce design files, 115

MFD files, 115

schemas, 115

search paths, 17

Removing,

file boxes, 111

files, 111

MapForce design files, 111

MFD file boxes, 111

MFD files, 111

schema boxes, 111

schemas, 111

user defined-tools, 140

Renaming,

directories, 74

files, 74

folders, 74

MapForce design files, 74

MFD files, 74

schemas, 74

toolbar, 139

user-defined tools, 140

Resetting,

all toolbars, 139

context menus, 145

hotkeys, 142

keyboard shortcuts, 142

menu bars, 145

search paths, 18

shortcuts, 142

toolbars, 139

Resizing,

file boxes, 120

MFD file boxes, 120

schema boxes, 120
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SAD files,

closing, 78

creating, 78

opening, 78

saving, 78

Saving,

designs, 78

SAD files, 78

Schema,

creating, 73

Schema boxes,

aligning, 120

aligning on grid, 76

arranging, 83

auto-sizing, 83

changing order, 120

collapsing structure, 83

expanding structure, 83

lining up, 120

resizing, 120

SchemaAgent,

Client documentation, 62

Introduction, 7

main features, 10

SchemaAgent Server, 49

tutorial, 20

SchemaAgent Client,

connecting to a server, 70

connecting to LocalServer, 71

connecting to SchemaAgent Server, 71

customizing, 137

graphical user interface, 65

GUI, 65

installation, 63

interface, 65

overview, 62

starting, 64

user interface, 65

SchemaAgent Server,

connecting to, 71

exiting, 54, 60

graphical user interface, 56

GUI, 56

hiding, 54

interface, 56

overview, 49

showing, 54

shutting down, 60

starting, 53

user interface, 56

Schemas, 75

deleting, 75

displaying (tutorial), 26

displaying relations, 93

editing, 75

ghost schemas, 111

inserting, 79

Quick information, 105

reloading, 115

renaming, 74

unknown schemas, 75

viewing, 84

viewing relations, 93

Search paths,

adding, 13

configuring, 12

editing, 13

reloading, 17

resetting, 18

tutorial, 22

Selecting,

component relations, 90

connector lines, 90

files, 109

IIR relationships, 90

MapForce design files, 109

MFD files, 109

multiple files, 109

related files, 109

relations, 90

schemas, 109

source, 123

target, 123

Selection,

copying, 109

pasting, 109

synchronizing, 109

Server,

connecting to, 70

network server, 71

SchemaAgent Server, 71
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Setting up SchemaAgent Client, 21

Setup, 21

Shortcuts,

assigning, 142

de-assigning, 142

resetting all, 142

Showing,

component origin, 98

component usage, 98

grid, 76

IIR relationships, 90

MapForce design files, 101

MFD files, 101

Quick information, 105

related components, 98

relation path, 123

relations, 90

SchemaAgent Server, 54

Shutting down,

SchemaAgent Server, 60

Silent Installation,

modify MSI file, 165

package license files with installer, 165

Software product license, 164

Sorting,

by name, 123

by width, 123

file boxes, 123

Starting,

SchemaAgent Client, 64

SchemaAgent Server, 53

Stylesheets,

displaying relations, 94

viewing relations, 94

Synchronizing selections, 109

T
Toggling,

toolbars, 60

Toolbar,

activating, 139

creating, 139

customizing, 139

deleting, 139

renaming, 139

resetting, 139

SchemaAgent Client, 68

Toolbars,

toggling on and off, 60

Tools,

adding user-defined, 140

changing the sequence, 140

customizing, 140

removing user-defined, 140

renaming user-defined, 140

Tutorial,

configuration, 20

configuring a search path, 22

connecting to a server, 21

connecting XMLSpy, 31

creating IIR relationships, 26

creating imports, 29

creating includes, 26

creating redefines, 28

displaying schemas, 26

example files, 20

importing types, 39

including types, 32

including types using only XMLSpy, 41

installation, 20

license, 20

making elements global, 31

opening a Design window, 26

overview, 20

redefining types, 34

search paths, 22

set up, 21

starting SchemaAgent Client, 21

using redefined types, 37

using XMLSpy as client, 30

viewing MapForce design files, 47

viewing MFD files, 47

viewing updated relationships, 45

U
Unknown schema, 75

User interface,

Design window (SchemaAgent Client), 68
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User interface,

Explorer (SchemaAgent Client), 66

Menu bar (SchemaAgent Client), 68

Overview window (SchemaAgent Client), 67

SchemaAgent Client, 65

SchemaAgent Server, 56

Toolbar (SchemaAgent Client), 68

User reference,

SchemaAgent Server, 60

V
Viewing,

component origin, 98

component usage, 98

configuration file, 18

design files (tutorial), 47

files, 76

IIR relationships, 90

MapForce design files, 76, 101

MapForce design files (tutorial), 47

MapForce Design relations, 98

MFD file relations, 98

MFD files, 76, 101

MFD files (tutorial), 47

Quick information, 105

related component, 98

relation path, 123

relations, 90

schema relations, 93

schemas, 76, 84

stylesheet relations, 94

updated relationships (tutorial), 45

WSDL relations, 97

XML instance relations, 94

XML schema relations, 93

XSLT stylesheet relations, 94

W
WDSL files,

displaying relations, 97

viewing relations, 97

Windows,

Design, 68

Explorer, 66

Overview, 67

X
XML instances,

displaying relations, 94

toggling input/output in MFDs, 98

viewing relations, 94

XMLSpy,

as client (tutorial), 30

connecting (tutorial), 31

XSLT stylesheets,

changing order, 94

displaying relations, 94

viewing relations, 94

Z
Zooming, 76
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